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Scope of Manual

This guide is designed to assist you in getting started with use of NightSimTM on Power-
MAX OSTM and LinuxTM. NightSim is a real-time tool that provides a graphical user int
face to the frequency-based scheduler and performance monitor services.

Structure of Manual

This manual consists of five chapters, three appendixes, a glossary, and an index. A
description of the chapters and appendixes is presented as follows.

• Chapter 1 introduces you to the concepts and components of NightSim, a
real-time tool that is part of the NightStarTM development environment.

• Chapter 2 provides an overview of the primary factors that need to be taken
into account prior to running NightSim on PowerMAX OS. 

• Chapter 3 explains the procedures for beginning and ending a NightSim
session and explains how to get help. 

• Chapter 4 describes the frequency-based scheduler and introduces the
components of NightSim’s Scheduler window.

• Chapter 5 describes the performance monitor and introduces the
components of NightSim’s Monitor window.

• Appendix A discusses the format of configuration files used by NightSim
as well as the automatic conversion of configuration files created by Night-
Sim 2.4 and earlier versions.

• Appendix B presents the configurable X resources, NightStar resources,
and widget hierarchy for NightSim.

• Appendix C details the procedures for reporting bugs found in NightSim.

The glossary contains definitions of technical terms that are important to understa
the concepts presented in this book.

The index contains an alphabetical reference to key terms and concepts and num
pages where they occur in the text.
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Syntax Notation

The following notation is used throughout this manual: 

italic Books, reference cards, and items that the user must specify ap
in italic type. Special terms may also appear in italics.

list bold User input appears in list bold  type and must be entered exactl
as shown. Names of directories, files, commands, options and sy
manual page references also appear in list bold  type.

list Operating system and program output such as prompts and mes
and listings of files and programs appear in list  type.

[  ] Brackets enclose command options and arguments that are opti
You do not type the brackets if you choose to specify such option
arguments

Referenced Publications

The following publications are referenced in this document:

0890300 X Window System User’s Guide 

0890380 OSF/Motif Documentation Set 

0890423 PowerMAX OS Programming Guide 

0890430 System Administration Volume 2 

0890466 Real-Time Guide 

0890479 PowerMAX OS Guide to Real-Time Services 

0891080 Diskless Systems Administator’s Guide

0891082 Real-Time Clock and Interrupt Module User’s Guide
vi
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1

This chapter introduces you to the concepts and components of NightSim, a real-tim
that is part of the NightStar development environment. NightSim provides a graphica
interface to the major functions associated with the frequency-based scheduler and the
performance monitor.

Overview of NightSim 1

NightSim allows you to perform the entire range of functions associated with freque
based scheduling.   You can perform the major functions of configuring a sched
setting up a timing source, scheduling programs, saving and restoring a sche
configuration, running a simulation, and viewing scheduling data. The principal feat
of the frequency-based scheduler are described in the section that follows. 

NightSim also allows you to perform the entire range of functions associated with
performance monitor. You can perform the major functions of selecting a schedu
clearing existing performance monitor values, enabling and disabling perform
monitoring, including and excluding interrupt time, and viewing performance mon
values. The principal features of the performance monitor are described in “Overvie
the Performance Monitor” (see p. 1-2).

In addition, NightSim fully supports frequency-based scheduling in a distributed envi
ment, using closely-coupled and/or loosely-coupled systems, providing the ability for a
single invocation of NightSim to schedule and monitor processes distributed across 
ple single-board computers (SBCs), or multiple systems loosely-coupled using an R
(Real-Time Clock and Interface Module) board. (In this manual, loosely-coupled sys
using an RCIM chain are referred to as RCIM-coupled systems.)  An additional capability
is NightSim’s ability to configure a frequency-based scheduler on any system in you
work, not just the NightSim host.

NightSim is also integrated with other NightStar tools.  NightSim may be invoked dire
from the NightBench Program Development Environment.  NightSim also provides
ability to schedule your programs under the control of the NightView Source-Le
Debugger, making it easy to gain control of scheduled programs in order to set b
points or monitorpoints early on in the execution of the program, before it attaches t
FBS.

NightSim’s graphical user interface is based on the X Window SystemTM  and
OSF/Motif.TM 
1-1
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Overview of the Frequency-Based Scheduler 1

The frequency-based scheduler, or FBS, is a task synchronization mechanism that allo
you to run processes at specified frequencies. Frequencies can be based on high-re
clocks, an external interrupt source, or completion of a cycle. The frequency-b
scheduler provides a mechanism for initiating processes at the specified frequenc
processes are then scheduled via the standard  priority-based scheduler. 

When used in conjunction with the performance monitor, the FBS can be use
determine the best way of allocating processors to various tasks for a parti
application. Chapter 4, “Using the Scheduler Window,” fully describes the features
capabilities of the frequency-based scheduler. 

Overview of the Performance Monitor 1

The performance monitor is a mechanism that allows you to monitor use of the CP
processes that are scheduled on a frequency-based scheduler. The values obtai
help in determining whether processes need to be redistributed among processo
improved load balancing and processing efficiency. You can obtain performance mo
values by process or processor and can specify whether time spent servicing inte
should be included or excluded from the values. The performance monitor also ma
possible to monitor a processor’s idle and spare time. By examining the amount of idle
and spare time on each processor, you can identify the processors that have the 
load and determine the additional amount of CPU time that can be used for sched
real-time processes. Chapter 5, “Using the Monitor Window,” fully describes the feat
and capabilities of the performance monitor.

Overview of the Graphical User Interface 1

NightSim’s graphical user interface has two major windows: the Scheduler window and
the Monitor window. The Scheduler window provides access to the key operatio
associated with frequency-based scheduling. The Monitor window provides access to the
key operations associated with performance monitoring. An overview of each windo
provided in the sections that follow.

The Scheduler Window 1

Figure 1-1 presents the Scheduler window. This window allows you to configure a
frequency-based scheduler; set up a timing source for it; schedule programs on it;
stop, and resume a simulation; and view scheduling data.
1-2
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Figure 1-1.  Scheduler Window

The Scheduler window also allows you to save a scheduler configuration to a file an
open and save a configuration file that you have previously created. It shows wheth
window is active (associated with a scheduler that exists on the system) or inactive
associated with a scheduler that exists on the system) and whether the selected sc
is running or stopped. It displays the current minor cycle and current major frame for the
simulation, and it graphically shows the execution cycle for each process that is sche
on the scheduler.

Chapter 4, “Using the Scheduler Window,” provides a detailed explanation of each a
the Scheduler window and provides reference information for all of the fields a
controls in each area.

The Monitor Window 1

Figure 1-2 presents the Monitor  window. This window allows you to monitor the
performance of selected FBS-scheduled processes scheduled on one or more pro
on a selected scheduler. It allows you to display performance monitor values for sel
FBS-scheduled processes, clear performance monitor values for all FBS-sche
processes scheduled on one or more CPUs, and specify whether or not time spent
ing interrupts is to be included in performance monitor timing values.
1-3
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Figure 1-2.  Monitor Window

The Monitor  window also allows you to specify whether performance monitori
information is to be displayed in the Monitor window or written to a selected file. In
either case, you may specify the types of information that are to be reported, the reso
with which performance monitor timing values are displayed (for example, microseco
tens of microseconds, milliseconds), and the rate at which values are to be updated.

The Monitor window allows you to specify a frequency-based scheduler with which
window is to be associated.  It shows whether the scheduler is active or inactive, 
shows whether the simulation is running or stopped. If the scheduler is active, it dis
the current major frame and current minor cycle for the simulation.  The Monitor window
also shows performance monitor values for selected processes.

Chapter 5, “Using the Monitor Window,” provides a detailed explanation of each are
the Monitor window and provides reference information for all of the fields and contr
in each area.

Overview of Closely-Coupled Support 1

NightSim presents an interface that makes it appear as though there is one frequ
based scheduler distributed across all the SBCs in a cluster.  The user must still assign
each process to a specific target computer, but NightSim presents all the processe
gered from a single timing source in a single window, making it appear as if there is
FBS controlling all the processes.  In reality, NightSim creates an FBS and configure
chosen timing source as a distributed timing device on each target system where the us
has scheduled processes (using the same scheduler key for each).

All frequency-based schedulers that are attached to the same remote timing devi
stopped, started and resumed together, thus maintaining the same number of fram
interrupts delivered to each scheduler residing on different SBC boards.

If the timing device is a real-time clock or an edge-triggered interrupt, the operating
tem ensures synchronization by starting the timing device after all target FBS’s have been
started.  However, if the timing device is an external device, NightSim has no control
when that source “fires,” opening the possibility that the target FBS’s will not start
synchronized. 
1-4
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Refer to the Diskless Systems Administator’s Guide (0891080) for information on config-
uring a closely-coupled system.

Overview of RCIM Support 1

NightSim supports the Real-Time Clock and Interrupt Module (RCIM).  An RCIM is
optional hardware module attached to a target system which contains the following inter-
rupt-generating devices:

• real-time clocks (RTCs)

• edge triggered interrupts (ETIs)

• programmable interrupt generators (PIGs)

Any of these devices may be used as the timing source for an FBS.

RCIMs may be connected via RCIM cables such that interrupts from one RCIM ma
distributed to other systems in the RCIM chain.

Each interrupt device on an RCIM may be configured as an RCIM-distributed or normal
device.  By default, each interrupt device is available for use on the attached target s
or within an attached cluster of closely-coupled systems.  If the interrupt device is config
ured as an RCIM-distributed device, interrupts are also distributed between target sy
using the RCIM cable.

NightSim provides full support for the creation, control, and performance monitorin
schedulers distributed across multiple SBC's and/or target computers in an RCIM 
utilizing an RCIM-distributed device.   NightSim provides an interface to the RCIM-c
pled scheduler in much the same way that it does for a closely-coupled scheduler, cr
the individual target schedulers on target systems.  In addition, NightSim handles reg
tion of the distributed interrupt source, providing control of all target schedulers as if 
were a single scheduler.

An RCIM-coupled scheduler provides synchronized control for starting, stopping,
debugging of programs scheduled across loosely-coupled target systems.
1-5
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This chapter provides an overview of the primary factors that need to be taken
account prior to running NightSim. These include software requirements, system con
ration requirements, user requirements, and performance considerations.

Software Requirements 2

Each of the NightSim target systems must have the following packages installed:

• nsimserver  - the NightSim server

• x11ipc  - the X Window System package containing libraries for inter-
process communication

• fbs  - the PowerMAX OS operating system package providing kernel sup-
port for the frequency-based scheduler, the performance monitor, and
rtcp(1) .

NOTE

For an explanation of the procedures for installing software pack-
ages, refer to the pkgadd(1M)  system manual page.

Configuration Requirements 2

There are certain system tunables on the target systems associated with the freq
based scheduler as well as system tunables on the target systems associated with 
formance monitor that may need to be set.  There may also be additional consider
when running NightSim on a closely-coupled system or across loosely-coupled systems.

After changing a tunable parameter, you must rebuild the kernel using idbuild(1M)
and then reboot your system.  For additional information on tunable parameters, re
the “Tunable Parameters” chapter of System Administration Volume 2.

It is necessary to add the fbs  kernel module when you are configuring the target.

It should also be noted that if you want to use the real-time clocks on any of the targe
tems, you need to add the rtc  kernel module when you configure the target.

If you want to use RCIM devices, you also need to add the rcim  and eti  kernel modules
when you configure the target.  See “RCIM-Coupled System Configuration” on page
2-1
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for other considerations when using NightSim on an RCIM-coupled configuration.  Also,
see the Real-Time Clock and Interrupt Module User’s Guide (0891082) for more informa-
tion.

NOTE

System tunables can be examined and modified using the kernel
configuration utility config(1M) .

Frequency-Based Scheduler System Tunables 2

The frequency-based scheduler has associated with it the following system tunab
parameters:

To determine whether the values of these parameters have been modified for your s
examine the /etc/conf/mtune.d/fbs  file.  You can change the value of either o
these parameters by using the idtune(1M)  command.

FBSMNI The maximum number of frequency–based schedulers
that can be configured at one time system–wide. The
default value for this quantity is 10. You cannot spec-
ify a value greater than 100.

FBSUNSCHEDMAX The maximum number of unscheduled processes tha
is permitted on a frequency-based scheduler. The
default value for this quantity is -1, which indicates
that the maximum number of unscheduled processes
permitted per scheduler is equal to the maximum
number of scheduled processes permitted on the
scheduler. This number is specified when the sched-
uler is configured (see “Using the Scheduler Configu-
ration Area”, p. 4-21).

A value other than -1 may be specified. This new
value will be the maximum number of unscheduled
processes permitted for all schedulers.

FBSCCSENABLED Specifies whether the CCS_FBS subsystem is
enabled.  See “Closely-Coupled System Configura-
tion” on page 2-3 for more information.

RCIM_MASTER_NAME
RCIM_DISTRIB_INTR0
...
RCIM_DISTRIB_INTR7

These tunables are required when RCIM-distributed
frequency-based schedulers are created.  See “RCIM
Coupled System Configuration” on page 2-4 for more
information.
2-2
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Performance Monitor System Tunables 2

The performance monitor services to which NightSim provides access require that 
high-resolution timing facility be configured into the kernel of the target systems. The
high-resolution timing facility provides a means of measuring each process’s or LW
(lightweight process’s) execution time. It is fully described in the PowerMAX OS Real-
Time Guide (0890466).  The performance monitor facility uses the times that are gath
for each process by the high-resolution timing facility to obtain its timing values. As s
ified by the user, these values may include or exclude time spent servicing interrupts

By default, the high-resolution timing facility is not configured into the kernel.  To de
mine whether  i t  is  conf igured in to your  kernel ,  examine the va lue of  
HIGHRESTIMING system tunable parameter in the /etc/conf/mtune.d/svc  file.
To configure the high-resolution timing facility, you must change the value of this tun
parameter from 0 to 1 by using the idtune(1M)  command.  This must be turned on fo
each system (server or client) where performance monitoring is desired.

Closely-Coupled System Configuration 2

There are some additional considerations when using NightSim on a closely-coupled con-
figuration.

The rdevfs  file system provides local access to timing devices that exist on some o
system.  You may wish to refer to the section “The Remote Device File System” in
PowerMAX OS Guide to Real-Time Services (0890479) for more information.

The CCS_FBS subsystem (support for the frequency-based scheduler in a closely-cou
configuration) must be added to each potential NightSim target system within the cluster.
This subsystem primarily checks kernel configuration options at system boot. 
“Subsystem Support” and “Modifying the Kernel Configuration” in the Diskless System
Administrator’s Guide (0891080) for more information.

Also, the FBSCCSENABLED system tunable should be properly set.  See “Frequen
Based Scheduler System Tunables” on page 2-2 for more information.  This wi
automatically configured on targets that have added the CCS_FBS subsystem.

NOTE

If the file server SBC is also going to be part of a closely-coupled
FBS simulation, then the user must manually configure the
rdevfs  and fbs  kernel  modules, and also enable the
FBSCCSENABLED tunable into the server’s kernel.  See “Modify-
ing the Kernel Configuration” in the Diskless System Administra-
tor’s Guide (0891080) for more information.

No te  tha t  whe n  you  c on f i gu re  you r  c l ose ly - coup le d  sys tem ,  t
/etc/dtables/nodes.vmeboot  file specifies information about how each client 
connected and how it boots.  NightSim uses this file to map board IDs to a hostnam
NightSim can use to communicate via networking with each SBC.  It is important that you
2-3
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specify an Ethernet hostname for a client only if it does, in fact, have an Ethernet inte
If you specify an Ethernet hostname, but the client cannot communicate via Ethe
NightSim may give you an error, saying it cannot start up a server on that client.

RCIM-Coupled System Configuration 2

There are some additional considerations when using NightSim on an RCIM-coupled con-
figuration.

If a frequency-based scheduler is to be distributed across multiple target systems, then
RCIM modules are required for each of the target systems (unless all the target sy
are contained solely within a cluster).

The following kernel modules must be enabled on all target systems involved in the
tributed scheduler:

- rdevfs  

- fbs  

- rcim  

- eti  (if ETI devices are to be used)

The following subsystems must be enabled on all target systems involved in the d
uted scheduler if they are part of a cluster:

RC_FBS

Each RCIM module must be configured with tunables similar to those mentioned b
for appropriate distribution of interrupts on each target system:

RCIM_MASTER_NAME
RCIM_DISTRIB_INTR_0
...
RCIM_DISTRIB_INTR_7

These tunables define the topology of the RCIM chain and the distribution of interr
along that chain.

NightSim cannot automatically determine which targets in an RCIM-distributed sched
are actually connected via RCIM cables; however, NightSim remembers system inte
nections as you configure RCIM-distributed schedulers.

Use of RCIM modules as timing devices for distributed schedulers requires that the R
interrupt device be registered on the host and target systems.  This registration is dy
in nature and is handled by NightSim as schedulers are configured, created, and rem
2-4
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User Requirements 2

To use NightSim, you must also ensure that certain user requirements related to r
shell access, environment variables, and privileges are met. These requiremen
described in the sections that follow.

Remote Shell Access 2

NightSim uses the rsh(1)  command on the NightSim host to execute programs on
remote systems, only if necessary.  When the Scheduler is in On-Line mode (see “On-
Line/Off-Line Operation” on page 4-5), if your timing host or any target system is not
same as the NightSim host, the rsh(1)  command will be used to start a NightSim server
process on each remote system.

The NightSim user must be able to use the rsh(1)  command to access each remote sy
tem involved and execute commands on those systems.

Ensure that for each remote system, there exists a login with the same username as
NightSim host.  In addition, the .rhosts  file in the home directory for that username o
each remote system must contain an entry for that username and the NightSim host,
the /etc/hosts.equiv  file on the remote system must contain the name of the Nig
Sim host.

If you use NightSim Scheduler only in Off-Line mode, it is not necessary to configur
systems for rsh(1)  use.  

See the rsh(1)  man page for more details.

Environment Variables 2

You must ensure that the value of your DISPLAY  variable is set to the name of your X
server.  You may determine whether the value of this variable is already set by typin
following at the system command prompt.

echo $DISPLAY 

If the value of the variable has been set, output similar to the following is displayed:

pubtek7:0.0

If the value has not been set, you may set it from the command line. The forma
specifying the name of your X server is as follows:

[ host]: server[. screen]

Host specifies the name of your X server; server specifies the server number; and screen
specifies the screen number. In most cases, the server number and screen number a
2-5
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Table 2-1 shows how to set the DISPLAY  variable from the command line by using differ
ent versions of the shell.

In addition, you may use the -display  X command-line option when invoking Night-
Sim.  This option has the following format:

-display  [ host]: server[. screen]

See the X Window System User’s Guide for more information about this option and
“Invoking NightSim” on page 3-1 for related information.

Privileges 2

PowerMAX OS supports a privilege mechanism through which processes are allow
perform sensitive system operations or override system restrictions. Some o
operations associated with the frequency-based scheduler and the performance monitor
require special privileges. These operations are related to configuration and remova
scheduler, scheduling and rescheduling of programs, and selection of the timing 
under which the performance monitor runs. One or a combination of the follow
privileges is required to perform these types of operations:

P_RTIME

P_CPUBIAS

P_TSHAR

Normally, NightSim automatically grants the above privileges to target processes.  H
ever, when scheduling a process under the NightView debugger (see “Debug” on
4-30), the user must ensure that appropriate privileges are granted to the NightView
sion.  Typically this is done by putting a tfadmin(1)  command at the end of the user
.profile  or .login  script:

exec tfadmin [role: cmd]

When a NightView session is initiated from NightSim, a telnet session is launche
execute the NightView dialogue.  The dialogue runs the user’s default shell, the
executing the user’s .profile  or .login  script during initialization.  The exec
tfadmin  command above causes the login shell to obtain the privileges associated
the optionally specified (or default) role for the user.  NightSim then takes control o

Table 2-1.  Setting the DISPLAY Variable

Type of Shell Command Line Entry

Bourne Shell DISPLAY=pubtek7:0.0
export DISPLAY

C Shell setenv DISPLAY pubtek7:0.0

Korn Shell export DISPLAY=pubtek7:0.0
2-6
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dialogue shell and executes commands on the user’s behalf to schedule the 
processes on an FBS.

Additionally, users may use the Edit Process window (see “Privileges” on page 4-32
to specify other privileges needed by their target processes as long as the user or
process is entitled to them.

Allowable privileges are determined by:

- the combined set of all privileges specified by the roles assigned to the user
on the target system (see adminuser(1)  and adminrole(1)  for more
information)

- the fixed privileges associated with the executable process on the target
system (see filepriv(1)  for more information)

For additional information on privileges, refer to the PowerMAX OS Programming Guide
(0890423) and the intro(2)  system manual page. 

Performance Considerations 2

To prevent the execution of NightSim from interfering with the execution of the real-t
application, it is recommended that you assign NightSim to the boot processor o
other processor on which real-time tasks are not running. You can assign NightSim to a
particular processor by invoking the run(1)  command from the shell and specifying th
–b  bias option. Prior to using the run  command for this purpose, you may wish t
determine which processor on your system is the boot processor. You can do 
invoking the run  command without specifying any arguments. On Series 6000 syste
the boot CPU is always 0. Note that this may not be the case for future architectures

For more information on use of the run(1)  command for these purposes, refer to the co
responding system manual page. 

In addition, NightSim has the ability to configure an FBS on any system in the netw
not just the NightSim host.  This capability allows the user interface to operate on a sys
other than the ones on which processes are scheduled, freeing the resources of thostarget
systems for the scheduled processes.
2-7
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This chapter explains the procedures for beginning and ending a NightSim session. 
explains how to get help and how to use accelerators.

Invoking NightSim 3

The NightSim tool is available on your system as /usr/bin/nsim . 

The format for executing nsim  on PowerMAX OS is as follows:

nsim  [-help ] [-version ] [-f  file] [-offline ] [-s  [[hostname,]key]] 
[-m [[hostname,]key]] [ - Xoption . . . ]

The format for executing nsim  on Linux  is as follows:

nsim  [-help ] [-version ] [-f  file] [-offline ] [-s  hostname,[key]] 
[-m hostname,[key]] [ - Xoption . . . ]

Options are described as follows:

-help This option allows you to display the usage information for Nigh
Sim and then exit.

-version This option allows you to display the version and copyrig
information for NightSim and then exit.

-f file This option allows you to specify the name of a file that conta
configuration and scheduling data for a selected frequency-based
scheduler.  You may specify a full or relative pathname for the file.

To save the configuration and scheduling data entered in a partic
Scheduler  window to a file, select the Schedu le r->Save
Conf ig F i le As  menu item from that Schedu le r  window.
Procedures are fully explained in “Save Config File As . . .” on pa
4-17.

You may also use a text editor to create or modify a configurat
file, following the format as described in “Configuration Fil
Format” on page A-1.

-offline Create Scheduler windows initially in Off-Line mode.  See
“On-Line/Off-Line Operation” on page 4-5 for more information.
3-1
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-s  [[hostname,]key] (PowerMAX OS)

-s  hostname[,key] (Linux)

This option allows you to create a Scheduler window.

The key parameter al lows you to specify the key for a fre-
quency-based scheduler that is active on your system. Key specifies
an integer value that identifies the scheduler.  If the optional key
parameter is not specified, the new Scheduler  window is inac-
tive—that is, it is not associated with a scheduler that exists on y
system.

The hostname parameter causes the window to be associated with
FBS that is active on that particular system.  If the optional hostname
parameter is not specified, the system defaults to the local h
(where NightSim is running).

NOTE

On Linux, the hostname is required, and must denote a host run-
ning PowerMAX OS with a NightSim server installed.

If an active scheduler associated with the specified key is found 
you have read permission for it, an active Scheduler window asso-
ciated with the key is created. See Chapter 4, “Using the Sched
Window,” for information about the Scheduler->Select Active
Scheduler menu item.

If a scheduler with the specified key does not exist, NightSim repo
an error.

This option may be used more than once; a Scheduler window will
be created for each occurrence of the option.

-m [[hostname,]key] (PowerMAX OS)

-m hostname[,key] (Linux)

This option allows you to create a Monitor window.

The key parameter allows you to create a Monitor window that is
associated with a particular frequency-based scheduler. Key specifies
an integer value that identifies the scheduler with which you wish 
Monitor window to be associated.  If you do not specify the option
key parameter and you have opened a Scheduler window, the new
Monitor window will display the same key as that displayed in t
Scheduler window.   

The hostname parameter causes the window to be associated with
FBS with the specified key on that particular system.  If the optiona
hostname parameter is not specified, the system defaults to the lo
host (where NightSim is running).
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NOTE

On Linux, the hostname is required, and must denote a host run-
ning PowerMAX OS with a NightSim server installed.

You must have read permission for the specified scheduler. 
must also have write permission for the scheduler if you wish to
able to enable or disable performance monitoring for processes
are scheduled on it.

This option may be used more than once; a Monitor window will be
created for each occurrence of the option.

- Xoption You may also specify any standard X Toolkit command-line optio
Such options include -bg  color to set the color for the window back
ground; -fg  color to set the color to use for text or graphics; an
-xrm resourcestring to set selected resources. For a complete list
these options, refer to the X(1)  system manual page. 

When invoking NightSim, you may specify options in any order; you may specify the-f ,
-s , and -m options one or more times as illustrated by the following example:

nsim  -s buzzard,4  -s papio,5  -m papio,5  -f config_file

In this case, NightSim opens two active scheduler windows—one associated with the
scheduler identified by key 4 on target buzzard  and one associated with the schedul
identified by key 5 on target papio  — a monitor window associated with the schedul
identified by key 5 on target papio , and an inactive scheduler window associated with
the scheduler identified in config_file .

You may also invoke NightSim without specifying any options. Doing so allows you
display an inactive Scheduler window. An inactive Scheduler window is one that is
not associated with a scheduler that exists on the system.

NOTE

On Linux, invoking NightSim without any options will open a
NightSim Main Window.  It may be used to specify a host on
which to open an inactive Scheduler or Monitor window.

The steps for invoking NightSim are as follows:

1. Log in to your system.

2. Ensure that the value of your DISPLAY variable is set to the name of your
X server (or use the -display  command-line option to the NightSim
command). Refer to “Environment Variables” on page 2-5 for more infor-
mation.

3. Type nsim  and any desired options after the system command prompt, and
press the Enter key.
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Getting Help 3

NightSim provides on-line help information through the Help menu which is accessible
via the menu bars in the Scheduler (see “Introduction to the Scheduler Window” o
page 4-8) and Monitor (see “Introduction to the Monitor Window” on page 5-7) win
dows.  Figure 3-1 presents this menu:

Figure 3-1.  Help Menu

Descriptions of the options on the Help menu follow.

On Context

Gives context-sensitive help on the various menu options, dialogs, or other pa
the user interface.

Help for a particular item is obtained by first choosing this menu option, t
click-ing the mouse pointer on the object for which help is desired (the mo
pointer will become a floating question mark when the On Context menu item is
selected).

In addition, context-sensitive help may be obtained for the currently highligh
option by pressing the F1 key. The HyperHelp viewer will open with the appro
pri-ate topic displayed.

On Help

Explains the various ways of obtaining help in NightSim and describes each o
items in the Help menu 

On Window

Displays help information for the current window

On Licenses

Displays status information about licenses and the license manager

On Version

Displays version and copyright information for NightSim
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NightSim also provides help information through the Help buttons that appear in othe
windows. When you click on the Help button in one of these windows, NightSim display
the help information for that window.

Using Accelerators 3

A set of keyboard accelerators is defined for use within NightSim to provide quick ac
to certain functions and menu items. Accelerators associated with menu items allow
to access those items whether or not the menu is posted. Table 3-1 contains a list
accelerators and the resulting actions; where applicable, it indicates the menu item
which the accelerators provide shortcuts. Note that you can define additional accele
through the use of X resources (refer to the X(1)  system manual page and “Widget Hier
archy” on page B-4 for the information needed to do so). 

Exiting NightSim 3

You may exit NightSim from the Scheduler or Monitor window by using one of the
following techniques:

• Select the NightSim->Exit menu item.

• Press <Control> <Q>.

Table 3-1.  Accelerators

Accelerator Menu Item Action

<Control> <W> NightSim->Close Window Closes the current Scheduler  or Monitor
window

<Control> <Q> NightSim->Exit Exits NightSim

<Control> <N> Scheduler->New Clears al l  information f rom the current
Scheduler window; resets the various areas
to blank or default values; and places the
window in the inactive state

<Control> <O> Scheduler->Open Config File In the current Scheduler window, opens a
scheduler configuration file that you have
previously saved 

<Control> <S> Scheduler->Save Config File Saves the configuration and scheduling dat
entered in the current Scheduler window in
the file that is associated with the window

F1 Displays context help for the component tha
currently has the focus
3-5
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This chapter describes the frequency-based scheduler and explains how scheduler
frequency is defined and how processes are scheduled. It introduces the compon
NightSim’s Scheduler window and describes the use of each component.

Understanding the Frequency-Based Scheduler 4

The frequency-based scheduler is a task synchronization mechanism that allows you
run processes at frequencies that you specify. Frequencies can be based on high-re
clocks, an external interrupt source, or completion of a cycle. The frequency-based s
uler provides a mechanism for initiating processes at the specified frequency. The
cesses are then scheduled via the standard PowerMAX OS priority-based scheduler

The frequency–based scheduler provides you with the ability to:

• Define FBS frequency in terms of the duration of a minor cycle and the
number of minor cycles per major frame

• Specify the scheduling parameters with which processes are scheduled

• Detect frame overruns for all FBS–scheduled processes

• View the status of FBS–scheduled processes

• Remove one or all FBS–scheduled processes from a scheduler

• Reschedule an FBS–scheduled process

• Start, stop, and resume scheduling on a frequency–based scheduler

• Connect a timing source to and disconnect it from a frequency–based
scheduler

• Control use of the real–time clock device as the timing source for a
frequency–based scheduler

• Configure up to 100 frequency–based schedulers system–wide in a single
processor or multiprocessor environment

• Use both frequency–based scheduling and static priority scheduling
simultaneously

In addition, NightSim provides the following additional capabilities for your convenien

• Specify input and output files for scheduled processes

• Specify a working directory for scheduled processes.
4-1
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• Schedule processes under xterm(1)  terminal windows, providing the
option of interactive behavior

• Schedule processes under the NightView debugger

• Configure working privileges for scheduled processes.

NOTE

Some of these additional features are not available for schedulers
started via a saved script.

How Is Scheduler Frequency Defined? 4

You configure a frequency–based scheduler, in part, by defining the number of minor
cycles that compose a major frame. Minor cycles and major frames have associated w
them a duration of time that you can define by using a timing source for the schedule
timing source can be the end of a minor cycle, a real–time clock, an edge–triggered
rupt, or a user–supplied device. Procedures for using each of the devices as a 
source are explained in detail in the PowerMAX OS Guide to Real-Time Services.

If you use end-of-cycle scheduling, scheduling is triggered when the last process tha
scheduled during the current minor cycle of the current major frame completes its pro
ing.

If you use a real–time clock as the timing source, you can specify the period in micr
onds or the frequency in hertz.

How Are Processes Scheduled? 4

You schedule processes to run at a certain frequency by specifying the first minor cycle in
which the process is to be wakened in each major frame (called the starting base cycle)
and the frequency with which it is to be wakened (called the period). If, for example,
schedule “Process 1” with a starting base cycle of zero and a period of two, the process
will be wakened once every two minor cycles, starting with the first minor cycle in
frame. If you schedule “Process 2” with a starting base cycle of one and a period of
that process will be wakened once every four minor cycles, starting with the second m
cycle in the frame. If you then schedule “Process 3” with a starting base cycle of two 
period of two, that process will be wakened once every two minor cycles, starting wit
4-2
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third minor cycle in the frame. On a frequency–based scheduler configured with 100
minor cycles per major frame, these processes will be wakened as illustrated in Tabl

The maximum frequency with which you can schedule a process is once per minor
(a period of one); the minimum frequency is once per major frame (in the case o
example, a period of 100).

A process runs until it calls an FBS library routine that causes it to sleep until th
frequency–based scheduler wakes it again. The frequency–based scheduler wake
sleeping processes that are scheduled to be wakened in the current minor cycle
current major frame and repeats the process for each minor cycle in the current fra
continues to repeat the entire process on every major frame until the scheduler is dis
A scheduler configured with 100 minor cycles per major frame, a minor cycle duratio
10,000 microseconds (0.01 second), and a major frame duration of one second 
processes as illustrated in Table 4-2. 

Table 4-1.  Process Scheduling

Minor Cycle Processes Wakened

0 Process 1

1 Process 2 

2 Process 1, Process 3 

3 

4 Process 1, Process 3 

5 Process 2 

... 

97 Process 2 

98 Process 1, Process 3

99 

Table 4-2.  Scheduler Operation

Major Frame Time Minor Cycle Processes Wakened

(sec.)

0 0 0 Process 1

 0.01 1 Process 2

 0.02 2 Process 1, Process 3

 ...

 0.97 97 Process 2

 0.98 98 Process 1, Process 3

 0.99 99
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As illustrated in Table 4-2, when the current major frame is zero and the current m
cycle is zero, the scheduler wakes “Process 1.” After 0.01 second, it wakes “Proce
after 0.02 second, it wakes “Process 1” and “Process 3”; and so on. At one second
the current major frame becomes one, the current minor cycle becomes zero again, a
scheduler wakes “Process 1.” After .01 second, it wakes “Process 2”; after .02 seco
wakes “Process 1” and “Process 3”; and so on. The scheduler continues repeatin
process for as long as it is enabled.

It is important to note that a process may not always run at the frequency that you
specified. A frame overrun occurs when a scheduled process does not finish its proces
before it is scheduled to run again. Overrun counts are maintained for each process 
each scheduler. You can obtain information on overruns by querying a process 
Monitor window (see Chapter 5, “Using the Monitor Window”). When you schedul
process on a selected scheduler, you have the option of ensuring that the sched
stopped when that process causes a frame overrun.

For additional information on the frequency-based scheduler, refer to the PowerMAX OS
Guide to Real-Time Services.   

1 1.00 0 Process 1

 1.01 1 Process 2

 1.02 2 Process 1, Process 3

 ...

 1.97 97 Process 2 

 1.98 98 Process 1, Process 3

 1.99 99

 ...  

n n.00 0 Process 1

 n.01 1 Process 2

 n.02 2 Process 1, Process 3

 ..  

 n.97 97 Process 2

 n.98 98 Process 1, Process 3

 n.99 99

Table 4-2.  Scheduler Operation (Cont.)

Major Frame Time Minor Cycle Processes Wakened

(sec.)
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On-Line/Off-Line Operation 4

NightSim provides two modes of operation for a Scheduler, On-Line and Off-Line.
You can toggle the current state by pressing the On-Line/Off-Line button on either the
NightSim Scheduler window (see “On-Line/Off-Line” on page 4-20)  or the Edit Pro-
cess window associated with it (see “On-Line/Off-Line” on page 4-29).

By placing a NightSim Scheduler into an Off-Line state, immediate checking of the
information entered in either the NightSim Scheduler window or its associated Edit Pro-
cess window can be avoided.  When in Off-Line mode, the NightSim Scheduler will no
communicate with any servers on any timing host or target system of the Scheduler.

This is useful when creating a configuration for future use that deals with target sys
which may not currently exist or may not be currently accessible.  The values entere
Scheduler while it is Off-Line will be checked when the mode is changed to On-Line.

There are two ways to request a transition to On-Line mode:

1. Press the On-Line/Off-Line button on either the NightSim Scheduler or
its associated Edit Process window.  This toggles the value on the face
of the button.

2. Press the Set Up button on the Scheduler window.

In each of these cases, when going from Off-Line to On-Line, the information entered in
the Scheduler window and its associated Edit Process window is examined for correct-
ness given the current state of the timing host and target systems.  NightSim serve
started if necessary, and all scheduled process attributes are checked for correctnes

If errors are found in the configuration, the user will be guided through the list of is
discovered in the examination via the Verify Scheduler dialog.

Verify Scheduler 4

NightSim provides two modes of operation for a Scheduler, On-Line and Off-Line (see
“On-Line/Off-Line Operation” on page 4-5).  When going from Off-Line to On-Line,
the information entered in the Scheduler window and its associated Edit Process win-
dow is examined for correctness given the current state of the timing host and targe
tems.

If errors are found in the configuration, the user will be guided through the list of is
discovered in the examination via the Verify Scheduler dialog.  An example of such an
error is shown below.
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Figure 4-1.  Verify Scheduler Dialog

The operation of the buttons in the Verify Scheduler dialog is as follows:

Retry On-Line

If all problems found during the current verification process have been attende
the user may press this button to re-attempt  the transition to On-Line.

Previous Issue

Pressing this button will cycle to the previous issue found during the current ve
cation process.  The text describing the problem will be displayed in the Veri fy
Scheduler dialog.

Next Issue

Pressing this button will cycle to the next issue found during the current verifica
process.  The text describing the problem will be displayed in the Verify Sched-
uler dialog.

Remain Off-Line

This button allows the user to continue to work off-line in lieu of the proble
found and attempt to transition to On-Line at a later time.

Help

This button displays appropriate information related to the problem currently 
played in the Verify Scheduler dialog.

For each issue, NightSim will highlight the label associated with the field most likely t
of use in correcting the problem.  If that field is on a window that is not visible, Night
will raise the appropriate window to the top of the display.  Below is a portion of
NightSim Scheduler window corresponding to the error listed in Figure 4-1.  Note tha
Timing host field is highlighted since the host name entered was invalid.
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Figure 4-2.  Errors found during transition to on-line

After making the appropriate changes, the user may retry the transition to On-Line mode
or may choose to remain in Off-Line mode.  If new problems are discovered when tran
tioning to On-Line mode, the Verify Scheduler window will re-appear.
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Introduction to the Scheduler Window 4

The Scheduler window allows you to configure a frequency-based scheduler; select a
timing source for it; schedule programs on it; start, stop, and resume a simulation
view scheduling data.

The Scheduler window consists of the following components:

• Menu Bar 

• On-Line/Off-Line Status Area 

• Configuration File Name Area 

• Scheduler Configuration Area 

• Process Scheduling Area 

• Scheduler Control Area 

• Simulation Control Area 

• Run Status Area 

Figure 4-3 identifies the location of each of these components in the Scheduler window.
Note that this window contains sample data associated with a scheduler that exists 
system.

Figure 4-3.  Sample Scheduler Window 

Scheduler
Control
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Simulation
Control
Area

Run
Status
Area

Process
Scheduling

Area

Menu Bar

Scheduler
Configuration

Area

Configuration
File Name 

Area

On-Line/Off-Line
Status
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Procedures for using each component of the Scheduler window are described in the
sections that follow.

Using the Scheduler Window Menu Bar 4

The Scheduler Window menu bar is a part of the Scheduler window (see “Introduc-
tion to the Scheduler Window” on page 4-8).

The Scheduler Window menu bar provides access to the following menus:

• NightSim 

• Scheduler 

• Help 

Each menu is described in the sections that follow.
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The NightSim Menu 4

The NightSim  menu appears on the Scheduler  window menu bar (see “Using the
Scheduler Window Menu Bar” on page 4-9).

The NightSim menu on the Scheduler Window contains commands related to th
global operation of NightSim.  Figure 4-4 presents this menu.

Figure 4-4.  NightSim Menu

Descriptions of the options on the NightSim menu follow.

Create Scheduler Window

This option allows you to create a new Scheduler window. The new window is
inactive—that is, it is not associated with a scheduler that exists on your system
text fields contain blanks or default values. You may create any numbe
Scheduler windows.

Create Monitor Window

This option allows you to create a new Monitor window. If the Scheduler
window from which you create the window is associated with an existing sched
the key and target for that scheduler will be displayed in the Status Area of the n
Monitor window.  In addition, if the scheduler is active, scheduled processes
be listed in the Output Area of the new Monitor window.  Use of the Monitor win-
dow is fully explained in Chapter 5, “Using the Monitor Window.”

Duplicate Window

This option allows you to create a new Scheduler window with the same configu-
ration as that of the Scheduler window from which this option was selected. 

Close Window

This option allows you to close the current Scheduler window. If the window is
untitled and contains unsaved changes, NightSim displays the warning dialog
Figure 4-5 presents.
4-10
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Figure 4-5.  Save Changes Dialog:  Untitled Window

If you proceed with the current action without saving, these changes will be los
you click on the Yes  button to save the changes, NightSim displays the file se
tion dialog that Figure 4-6 presents.  If you click on the No button, the changes will
be discarded.  If you click on the Cancel button, the action is aborted.

Figure 4-6.  Save Configuration File Dialog

To select the file in which to save the changes, use the directory text area, file 
area, list of directories, list of files, and file selection text area as appropriate. A
making a selection, you may save the changes to the selected file, search for a
file, cancel the operation, or display help related to the dialog.

If the Scheduler window is associated with a configuration file name and conta
unsaved changes, NightSim displays the warning dialog that Figure 4-7 presen
4-11
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Figure 4-7.  Save Changes Dialog: Titled Window

If you proceed with the current action without saving, these changes will be los
you click on the Yes  button, the changes are saved in the file associated with
window.  If you click on the No button, the changes will be discarded.  If you clic
on the Cancel button, the action is aborted.

If the window from which you select Close Window is the only window that you
have open, NightSim displays the question dialog that Figure 4-8 presents.

Figure 4-8.  Confirm Exit Dialog

You may confirm that you wish to exit, continue to keep the window open
display help related to the dialog.

Exit

This option allows you to exit NightSim. If you have open Scheduler windows
that are untitled and contain unsaved changes or if you have an active sche
NightSim displays the warning dialog that Figure 4-5 presents (see p. 4-11).
each case, you may save the changes, close the window without saving the ch
cancel the close operation, or display help related to the dialog. If you click on
Yes  button to save the changes, NightSim displays the file selection dialog
Figure 4-6 presents (see p. 4-11). 

If you have open a Scheduler window that is associated with a configuration fil
name and contains unsaved changes, NightSim displays the warning dialog
Figure 4-7 presents. If you click on the Yes button, the changes are saved in the fi
associated with the window.

The warning dialogs are displayed for each window that contains unsaved cha
4-12
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The Scheduler Menu 4

The Scheduler menu appears on the Scheduler window menu bar (see “Using the
Scheduler Window Menu Bar” on page 4-9).

The Scheduler menu contains commands that affect the current Scheduler window.
Figure 4-9 presents this menu.

Figure 4-9.  Scheduler Menu

Descriptions of the options on the Scheduler menu follow.

New

This option allows you to clear all information from the current Scheduler
window; reset the various areas to blank or default values; and place the wind
the inactive state.  The timing host is preserved, however.

If the window is untitled and contains unsaved changes, NightSim displays
warning dialog that Figure 4-5 presents (see p. 4-11).   You may save the cha
clear the window without saving the changes, cancel the operation, or display
related to the dialog.   If you click on the Yes button to save the changes, NightSim
displays the file selection dialog that Figure 4-6 presents (see p. 4-11).

If the window is associated with a configuration file name and contains unsa
changes, NightSim displays the warning dialog that Figure 4-7 presents. You
save the changes, clear the window without saving the changes, cancel the 
tion, or display help related to the dialog. If you click on the Yes  button, the
changes are saved in the file associated with the window.

NOTE

If the window containing the unsaved changes is associated with
an active scheduler, the scheduler will continue to run although
the window is no longer associated with it.
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Select Active Scheduler . . . 

This option allows you to associate the current Scheduler window with a fre-
quency-based scheduler active on a given target system. When you select this
option, NightSim displays Figure 4-10.

If the window from which you select this option is untitled and contains unsa
changes, NightSim displays the warning dialog that Figure 4-5 presents (s
4-11).   You may save the changes, close the window without saving the cha
cancel the operation, or display help related to the dialog.   If you click on the Yes
button to save the changes, NightSim displays the file selection dialog 
Figure 4-6 presents (see p. 4-11).

If the window is associated with a configuration file name and contains unsa
changes, NightSim displays the warning dialog that Figure 4-7 presents. You
save the changes, close the window without saving the changes, cancel the 
tion, or display help related to the dialog. If you click on the Yes  button, the
changes are saved in the file associated with the window.

To assist you in selecting a scheduler, NightSim displays the selection dialog
Figure 4-10 presents.

NOTE

NightSim needs to communicate with a target system in order to
determine which schedulers are active.  This will occur even if the
existing Scheduler window is Off-Line.  This is to be expected
since the existing scheduler will be abandoned when an active
scheduler is selected, and because an active scheduler is necessar-
ily On-Line (see “On-Line/Off-Line Operation” on page 4-5).

Figure 4-10.  Select Active Scheduler Dialog

This dialog provides a list of the active schedulers for the system designated by th
Target field.  The Target defaults to your local host and the list contains the act
schedulers running on that particular system.  For instance, Figure 4-10 lists th
schedulers currently running on the host amber2 .
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You may change the Target  either by using the drop-down list (which lists th
hosts in your cluster or RCIM chain) or by typing the name of the target system into
the text field provided.  Entering an item in this field will populate the list with t
active schedulers on the specified target.

You may select a scheduler from the list that the dialog displays, or you may us
Scheduler Key  text field to enter the numeric key that is associated with the
desired scheduler. The key can be any positive integer value. Whether you 
from the list or enter a key, the selected scheduler must previously have 
configured, and you must have at least read permission for it; otherwise, Nigh
reports an error.

Once you select a scheduler, NightSim will determine whether that schedul
attached to a distributed timing device.  If so, NightSim will try to locate schedulers
on any other targets that have the same key and are attached to the same dist
timing device using the fbsinfo_rdev(3rt)  service.  All such schedulers
found will be treated as one “virtual” FBS and the combined information displaye
to the user.

If you successfully select an existing scheduler, the Scheduler window becomes
an active window associated with that scheduler. Information related to the sel
scheduler replaces information that the window contained prior to the operation

Open Config File

This option allows you to open a scheduler configuration file that you h
previously saved. The file is opened in the current Scheduler window.

If the window from which you select this option is untitled and contains unsa
changes, NightSim displays the warning dialog that Figure 4-5 presents (s
4-11). You may save the changes, close the window without saving the cha
cancel the operation, or display help related to the dialog. If you click on the Yes
button to save the changes, NightSim displays the file selection dialog 
Figure 4-6 presents (see p. 4-11). 

If the window is associated with a configuration file name and contains unsa
changes, NightSim displays the warning dialog that Figure 4-7 presents. You
save the changes, close the window without saving the changes, cancel the 
tion, or display help related to the dialog. If you click on the Yes  button, the
changes are saved in the file associated with the window. 

To assist you in specifying a configuration file to be opened, NightSim displays
file selection dialog that Figure 4-11 presents.
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Figure 4-11.  Open Config File Dialog

To select the file to be opened, use the directory text area, file mask area, l
directories, list of files, and file selection text area as appropriate. After makin
selection, you may open the selected file, search for another file, cance
operation, or display help related to the dialog. When you open the selected file
Scheduler window is associated with that file and displays the configuration a
scheduling data contained in the file.

NightSim will open the configuration file in Off-Line mode.  Once the file has bee
read in, NightSim will make a transition to On-Line mode unless the -offline
option was used on the command line, or the *offline  X resource was set to
True  (see “X Resources” on page B-1).  When this transition occurs, the 
scheduler will be verified.  See “On-Line/Off-Line Operation” on page 4-5 for m
information.

NOTE

NightSim 2.4 and earlier versions use a different format for this
configuration file.  NightSim 3.2 and later versions will automati-
cally convert these configuration files from the older format to the
newer format.  You will be prompted to save the converted con-
figuration when you close the Scheduler window.

Save Config File

This option allows you to save the configuration and scheduling data entered i
current Scheduler window in the file that is associated with the window.  If th
configuration file name has not yet been specified, this option is disabled;
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should use the Save Config File As... option.  See “Configuration File Format”
on page A-1 for a description of the format of this file as well as “Configuration F
Example” on page A-2 for the actual configuration file associated with Figure 
“Sample Scheduler Window,” on page 4-8.

NOTE

NightSim 2.4 and earlier versions use a different format for this
configuration file.  NightSim 3.2 and later versions will automati-
cally convert these configuration files from the older format to the
newer format.  You will be prompted to save the converted con-
figuration when you close the Scheduler window.

Save Config File As . . . 

This option allows you to specify the name of the file in which you wish t
configuration and scheduling data entered in the current Scheduler window to be
saved. 

When you select this option, NightSim displays the file selection dialog t
Figure 4-6 presents (see p. 4-11). After making a selection, you may save the c
configuration and scheduling data in the selected file, search for another file, ca
the operation, or display help related to the dialog.

See “Configuration File Format” on page A-1 for a description of the format of 
file as well as “Configuration File Example” on page A-2 for the actual configu
tion file associated with Figure 4-3, “Sample Scheduler Window,” on page 4-8.

NOTE

NightSim 2.4 and earlier versions use a different format for this
configuration file.  NightSim 3.2 and later versions will automati-
cally convert these configuration files from the older format to the
newer format.  You will be prompted to save the converted con-
figuration when you close the Scheduler window.

Save Script . . .

This option allows you to save the current configuration as a shell script conta
rtcp  commands.  The script may be run from any host in your network as long
has rsh(1)  access to all the targets, as well as the timing host (see “Remote 
Access” on page 2-5).  This script can then be used to recreate your schedule
figuration without the added overhead of NightSim, allowing your application
start up and run more quickly.  This can be extremely useful when dealing 
time-critical applications.

The main disadvantage of using this script instead of using NightSim is that yo
not get any monitoring capabilities.  This may be less important for systems tha
typically used in production environments but can be critical to those systems 
in a testing/development environment where the monitoring feedback that Nigh
provides can be invaluable.
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Another disadvantage is that the script does not support starting your proc
under NightView or xterm(1) .   Neither is there support for starting your sche
uled processes with privileges.  For these features, you must use the Nigh
scheduler to start your scheduler.

If a scheduler which makes use of xterm  or NightView is saved as a script, Night
Sim will ignore these points and schedule the processes directly.  If File input or
output is used, NightSim will honor those filenames, but if the scheduler uses Stan-
dard Input Stream or Standard Output Stream, NightSim will forcibly redi-
rect from or to /dev/null  in order to prevent rsh  from hanging while waiting for
input or output.

Figure 4-12.  Save Script Dialog

Note that this script is different from the rtcp -style configuration files found in
NightSim 2.4 and earlier versions.  See “Configuration File Format” on page 
for details on this new format.

Set Clock Resolution . . . 

This option allows you to select the resolution for a real-time clock that you h
selected as the timing source for a scheduler. The resolution indicates the dura
microseconds of one clock count. 

The duration of a minor cycle is defined by specifying the number of clock coun
per minor cycle (1 to 65,535) and the number of microseconds per clock cou
10, 100, 1000, or 10,000). You determine the duration of a major frame by multiply-
ing the duration of a minor cycle by the number of minor cycles per major frame
for example, you configure a scheduler with 100 minor cycles per major frame
you use as the timing source a real–time clock with a clock count of 10,000 a
clock count duration of one microsecond, each minor cycle has a duration of 10
microseconds, or 0.01 second, and each frame a duration of one second.
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When you select this option, NightSim displays the selection dialog that Figure
presents.

Figure 4-13.  Set Clock Resolution Dialog

You select the resolution by clicking on the toggle button and choosing one o
following options: 1, 10, 100, 1000, or 10000. You may apply your selection,
cancel the operation, or display help related to the dialog.

The resolution of the clock affects the valid range of the clock period.  See “C
period” on page 4-24.

Detailed Scheduler Info . . . (expert mode only)

The dialog associated with this option provides more information about the cu
FBS which may be of interest to some users.

This option appears on the Scheduler menu (see “The Scheduler Menu” on pag
4-13) only when the user is running in expert mode.  See the expert  resource
under “X Resources” on page B-1 for more details.

The Help Menu 4

The Help menu appears on the Scheduler window menu bar (see “Using the Schedule
Window Menu Bar” on page 4-9).

The Help menu provides access to the on-line help system.  See “Getting Help” on 
3-4 for detailed information about this menu and each of its items.
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Using the On-Line/Off-Line Status Area 4

The On-Line/Off-Line Status Area is a part of the Scheduler window (see “Introduction
to the Scheduler Window” on page 4-8).

The On-Line/Off-Line Status Area shows the name of the NightSim host as well a
On-Line/Off-Line toggle button indicating the current state of operation of the Sch
uler (see “On-Line/Off-Line Operation” on page 4-5). 

Figure 4-14.  Scheduler Window - On-Line/Off-Line Status Area

On-Line/Off-Line

NightSim provides two modes of operation for a Scheduler, On-Line  and
Off-Line (see “On-Line/Off-Line Operation” on page 4-5).  You can toggle the c
rent state by pressing the On-Line/Off-Line button on either the NightSim Sched
uler window or its associated Edit Process  window (see “The Edit Button” on
page 4-26).

By placing a NightSim Scheduler into an Off-Line state, immediate checking of the
information entered in either the NightSim Scheduler window or its associated Edit
Process window can be avoided.  When in Off-Line mode, the NightSim Sched-
uler will not communicate with any servers on any timing host or target system
the Scheduler.

This is useful when creating a configuration for future use that deals with target
tems which may not currently exist or may not be currently accessible.  The va
entered while Off-Line will be checked when the mode is changed to On-Line.

Using the Configuration File Name Area 4

The Configuration File Name Area is a part of the Scheduler window (see “Introduction
to the Scheduler Window” on page 4-8).

The Configuration File Name Area shows the name of the configuration file with wh
the current Scheduler window is associated. 

Figure 4-15.  Scheduler Window - Configuration File Name Area

If the window contains unsaved changes, the name is followed by a warning icon as
trated by Figure 4-15. When the Scheduler window is not associated with a configura
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tion file name, the Configuration File Name Area displays (unnamed) as illustrated by
Figure 1-1 (see p. 1-3). 

Using the Scheduler Configuration Area 4

The Scheduler Configuration Area is a part of the Scheduler window (see “Introduction
to the Scheduler Window” on page 4-8).

The Scheduler Configuration Area allows you to configure a frequency-based scheduler,
select the timing source that is to be used for it, and specify the permissions that are
associated with it.

Figure 4-16.  Scheduler Window - Configuration Area

Descriptions of the text fields and controls contained in the Configuration Area follow

Scheduler key

This field allows you to specify a key for the frequency–based scheduler that yo
wish to create. The key is a user–chosen numeric identifier with which the sche
will be associated. It can be any positive integer value. Note that the numb
schedulers that can be configured at one time cannot exceed the value of FBSMNI,
which is the maximum number of frequency–based schedulers permitted on
system (see Chapter 2, “Establishing the NightSim Environment,” for a descrip
of system tunable parameters).

Cycles per frame

This field allows you to specify the number of cycles that compose a frame on
specified scheduler.

Max. tasks per cycle

This field allows you to specify the maximum number of processes that ca
scheduled to execute during one cycle. 

Max. tasks in scheduler

This field allows you to specify the maximum number of processes that ca
scheduled on the specified scheduler at one time. The number must be less t
equal to the product that is obtained by multiplying the values specified in th
4-21



NightSim User’s Guide

d to

ating
s. The
as that
is

u
plied

t in
, if
r.
ith a

t

 is
Cycles per frame  and the Max. tasks per cycle text fields. Enter a number
ranging from one to the product of these values. 

Permissions

This field allows you to specify the permissions required for operations relate
the specified scheduler (see the system manual page for intro(2)  for information
on permissions associated with the frequency–based scheduler). Enter three octal
digits––the first indicating permissions granted to the owner, the second indic
those granted to the group, and the third indicating those granted to other user
octal method for setting permissions associated with a scheduler is the same 
used for specifying mode with the chmod command (for assistance in using th
method, see the system manual page for chmod(1) ). The default, 600, grants read
and alter (write) permission to the owner only.

Timing host

This field allows you to select the host of the timing source for the scheduler.  Yo
may enter the name of the host directly in the entry field or choose from the sup
list.  

This list contains a list of possible timing hosts.  NightSim maintains a lis
~/.NightSimHosts  of all hosts you ever used as a timing host.  In addition
any possible host is part of a cluster, this list includes all of the hosts in that cluste
It also includes all the hosts in all the clusters that share a common file server w
timing host.  Once selected, the Timing source menu is repopulated with the se
of devices available on that host.

On PowerMAX OS, this field defaults to the NightSim host.  On Linux, this field
empty by default.  The user must provide a Timing host name.

NOTE

The timing host cannot be changed while the scheduler is active;
you must first remove the scheduler.
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This option menu allows you to select the type of distribution for your schedule

Timing source

This option menu allows you to select the timing source for the scheduler. 
timing source can be the end of a minor cycle, a real-time clock, an edge-triggere
interrupt, or a user-supplied device.  Figure 4-17 presents an example of the o
menu. 

Figure 4-17.  Timing Source Option Menu

This list contains the set of devices available on the timing host.  Note that the
options that NightSim displays vary according to the devices that are configure
the system designated as the timing host and may change if the timing h
changed.  This list will be initially populated with the devices on the defaut tim
host.

NOTE

If the frequency-based scheduler will be distributed across multi-
ple target  systems,  the t iming device must support the
IOCTLVECNUM ioctl  operation or be an RCIM-distributed
device.

None Target processes will be scheduled only on the
timing host.  Interrupts will be delivered by the
FBS on the timing host directly.

Closely-Coupled Target processes will be scheduled on SBCs
within the closely-coupled cluster in which the
timing host resides.  Interrupts will be distrib-
uted to the FBS on each SBC in the cluster via
VME message passing.

RCIM-Coupled Target processes will be scheduled on target sys-
tems which are connected via a chain of RCIMs.
Interrupts will be distributed to the FBS on each
target via the RCIM cable.
4-23



NightSim User’s Guide

uring

 of a

ield
ld is

 by
 is a
label
 from
If you select the End of processing cycle option from the Timing source
option menu, scheduling is triggered when the last process that is scheduled d
the current minor cycle of the current major frame completes its processing.

NOTE

End of processing cycle is not valid for a distributed sched-
uler (i.e. you cannot assign processes to multiple targets and use
end-of cycle scheduling).  This is true for both Closely-Cou-
pled and RCIM-Coupled distributions (see “Distribution” on
page 4-23).

If you select a real-time clock, the Clock period text field is enabled so that you
can specify the information needed to set the clock. 

If you select the Other .  .  .  option, NightSim displays the dialog shown in
Figure 4-18. The text input area in this dialog allows you to specify the name
user-supplied device that you wish to use as the timing source. The Device Path-
name must be the name of a device file on the currently selected timing host.

NOTE

The user is responsible for ensuring that the Timing source is
appropriate for the selected Distribution.  If it is determined to
be inappropriate at the time that the scheduler is Set up, an error
message will be issued by NightSim.

Figure 4-18.  Other Device Prompt Dialog

Clock period

If you select a real-time clock as the timing source for the scheduler, this f
allows you to specify a value to be used in setting the clock.  Otherwise, this fie
disabled. 

You may specify the period in microseconds, milliseconds, hertz, or kilohertz
clicking on the toggle button and choosing the desired option. Below the field
label that shows the minimum and maximum values that are permitted. The 
changes according to the option you choose. Figure 4-19 presents the options
which you may choose.
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Figure 4-19.  Clock Period Options 

The valid range of the clock period is determined by multiplying the minimum 
maximum clock counts, 1 and 65535, by the clock resolution, which defaults t
microsends.  By chainging the clock resolution, you can increase or decreas
valid range of the clock period.  See “Set Clock Resolution . . .” on page 4-1
adjust the number of microseconds per clock count.

Using the Process Scheduling Area 4

The Process Scheduling Area is a part of the Scheduler window (see “Introduction to
the Scheduler Window” on page 4-8).

The Process Scheduling Area allows you to (1) add programs to a frequency-based sched
uler,  (2) remove FBS-scheduled processes from a scheduler, (3) resched
FBS-scheduled processes, (4) view scheduling data for current FBS-scheduled proc
and (5) select the processes for which scheduling data are to be displayed.

Figure 4-20.  Scheduler Window - Process Scheduling Area

The Process Scheduling Area contains a scrolling list of the processes that are cu
scheduled on a frequency-based scheduler and the parameters with which they have be
scheduled (CPU mask, scheduling policy and priority, starting minor cycle, and so on).
You can select the process or processes that you wish to reschedule or delete by c
on the respective item(s) in this list.

In addition, the Process Scheduling Area includes a grid that graphically show
execution cycle for each process in the list. The labels at the top of the grid show the
ber of the minor cycle. The minor cycles in which each process is scheduled to run
denoted by the appearance of the letter X in the appropriate column. You can use the ho
zontal and vertical scroll bars to scroll the visible contents of the grid.

The Process Scheduling Area provides a row of process controls below the l
FBS-scheduled processes. Each of these controls is described in the following sectio
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Edit . . . 

This push button allows you to add a program to a frequency-based scheduler or
reschedule an FBS-scheduled process. When you click on this button, NightSim displ
the Edit Process dialog that Figure 4-21 presents. Note that if you have selected a 
cess from the list of scheduled processes and then click on this button, the dialog co
the scheduling parameters for the selected process. NightSim also displays the Edit Pro-
cess dialog if you double click on a line in the list of scheduled processes.

Figure 4-21.  Edit Process Dialog
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Descriptions of the text fields and controls contained in the Edit Process dialog follow:

FPID

This field specifies the unique frequency-based scheduler process identifier that is
obtained when a program is scheduled on a scheduler. When a program has 
been scheduled on the scheduler, this field displays “(Scheduler is inactive)”.

Target System

This item specifies the target system on which this process is to be scheduled.

The list associated with this field is populated with appropriate target names fo
selected Distribution from the associated Scheduler Window.  

• If the selected Distribution is None, this list will contain only the
name of the timing host, which is the default value.  

• If Closely-Coupled distribution is selected, the list will contain
the target names of all the members of the cluster to which the timing
host belongs. 

• When RCIM-Coupled distribution is selected, this list contains the
names of all targets known to be connected to the timing host via the
RCIM chain. 

If the desired target is not available in the list, and the selected Distribution is
RCIM-Coupled , then you may enter the name of the desired target in 
combo-box.  NightSim will ask for confimation before adding the new target to
list of known targets connected via the RCIM chain.

If the new target is already part of an RCIM chain, NightSim will also ask how
add the target to the new chain.  You may either merge the two subchains tog
if appropriate, or remove the target first from the chain to which it was believe
be connected before adding it to the new chain.

If the target name you enter is not in the list of expected systems, then NightS
not aware that the target is connected to the same RCIM chain as the timing
NightSim will display the dialog in Figure 4-22. 
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Figure 4-22.  Add Target to RCIM Chain Dialog

This dialog is made up of two questions.  The second question will be graye
unless it is relevant.

The first question asks if the new target you entered is in the same RCIM cha
the  t im ing  hos t .   T he  new  ta rge t  w i l l  be  r em e mbered  in  t
~/.KnownTargetsFile  as being in the same RCIM chain as the selected tim
host.  Otherwise, NightSim will issue an error, and the target name will be rest
to its previous value.

If you check the radiobutton indicating that the new target is connected to the ti
host via an RCIM cable, and the new target is already known be part of ano
RCIM chain, then the second portion of the dialog will be activated.  You will
asked if the new target should be removed from its old RCIM chain and t
inserted into the timing host's RCIM chain, or whether the two RCIM chains sh
be merged.

NightSim keeps a persistent list in ~/.NightSimTargets  of targets on which
you have scheduled processes, including information regarding which of those
gets belong to the same RCIM chain.  NightSim uses this information to provi
meaningful selection of RCIM-distributed targets.

If the Edit Process dialog is used to modify the attributes of an existing proce
and the Target System is changed after the process has been created, Night
will pop up a warning dialog informing the user that the process will be killed 
recreated on the new target.  Processes cannot be moved between hosts intac

NOTE

NightSim does not allow you to assign processes to the same tar-
get system using two different names.  You must either assign all
the processes to the system using one name, or delete the pro-
cesses you assigned to one of the names (see “The Delete Button”
on page 4-36).
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On-Line/Off-Line

NightSim provides two modes of operation for a Scheduler, On-Line  and
Off-Line (see “On-Line/Off-Line Operation” on page 4-5).  You can toggle the c
rent state by pressing the On-Line /Off-Line button on either the the NightSim
Scheduler window or the Edit Process window associated with it  (see “Using th
On-Line/Off-Line Status Area” on page 4-20).

By placing a NightSim Scheduler into an Off-Line state, immediate checking of the
information entered in either the NightSim Scheduler window or its associated Edit
Process window can be avoided.  When in Off-Line mode, the NightSim Sched-
uler will not communicate with any servers on any timing host or target system
the Scheduler.

This is useful when creating a configuration for future use that deals with target
tems which may not currently exist or may not be currently accessible.  The va
entered while Off-Line will be checked when the mode is changed to On-Line.

Program Name

This field specifies the name of the process that you wish to schedule.  Enter 
or relative pathname (see “Pathname Expansion” on page 4-36).  The path
must be valid on the target system to which this process is assigned.  If you hav
selected a process from the list of FBS-scheduled processes prior to clicking on th
Edit button, this field contains the name of the FBS-scheduled process.

NOTE

You cannot change the name of a process while the process is run-
ning.  You must either stop the scheduler first or add a new pro-
cess with the desired name.

Select...

You may use the Select button to bring up the following file selection dialog
to choose the program you want to configure under the FBS.  Note that Night-
Sim displays files on the selected target system if it is reachable via the
work.  If the target system is unavailable, NightSim will disable file browsi
on the target system.  In addition, the Scheduler must be operating i
O n - L i n e  state in order  to  browse on the  ta rget f i le system (s
“On-Line/Off-Line Operation” on page 4-5).
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Figure 4-23.  Select a Program Dialog

NOTE

If the Program Name is /idle or /spare, then all of the follow-
ing fields which are inappropriate for the / id le and /spare
pseudo-processes are desensitized.  Only the CPU Bias  field is
valid for /idle or /spare.

Working Directory

You may specify the path to the working directory in which the scheduled pro
will run.  This path must be a valid directory name on the target system.  If the target
system is not available, or if the Scheduler is Off-Line  (see “On-Line/Off-Line
Operation” on page 4-5), the path must be a valid directory on the target syst
the time the program scheduler is created (i.e. when the Set up button is pressed on
the Scheduler window).

Debug

Schedule this process under the NightView debugger.  When the Schedule pro-
gram within a NightView dialogue checkbox is checked, the process will b
stopped at the point it begins execution, allowing early intervention for the purp
of setting breakpoints, watchpoints, etc.  A continue  command to NightView is
required to resume the execution of the scheduled process.
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NOTE

Scheduling processes under the FBS requires certain privileges
(see “User Requirements” on page 2-5).  In addition, the user may
configure additional privileges if permitted by the target system
(see “Privileges” on page 4-32).  

It is the responsibiliy of the user to ensure that appropriate privi-
leges are granted to the NightView session (see “Privileges” on
page 2-6 for details).  Most notably, the P_RTIME privilege is
required.  Attempts to schedule a process under the NightView
debugger without the P_RTIME privilege will fail.

X Terminal

Schedule the process in an xterm(1)  window.  An xterm  window may be used
in conjunction with scheduling the process under NightView as well, if so des
(see Debug above).  This permits the scheduled process to interact with the te
nal services provided by the xterm .

Read Input From

Select the input source, if any, for the scheduled process.  By default, as in pre
versions of NightSim, input is taken from the file, /dev/null .  When either the
Debug or X Terminal checkboxes are selected, the default is to permit inpu
come from the Standard Input Stream, but you may choose File input in either
case if your scheduled program needs a fixed input stream (see Input File below).

Input File

If File is selected for Read Input From, this field specifies the name of the inpu
file which the scheduled process will use.  By default, the file is /dev/null .  See
“Pathname Expansion” on page 4-36.

If the NightSim Scheduler is On-Line (see “On-Line/Off-Line Operation” on page
4-5), the pathname given must be a valid file on the target system with suffic
read permissions.

If the NightSim Scheduler is Off-Line, the path must represent a valid readable f
at the time the program scheduler is created (i.e. when the NightSim Scheduler
sitions to an On-Line mode of operation).

Send Output To

Select the way to manage output from your scheduled process.  If neithe
Debug and X Terminal  checkboxes are selected, you may select File output,
where the default file is /dev/null .  Output may be sent to an actual file specifie
in the Output File field, if desired.  By default, output is sent to the Standard
Output Stream of the scheduled process.

Output File

If File is selected for Send Output To, this field specifies the name of the outpu
file to generate.  The output file name may be a full pathname or may be a path
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relative to the Working Directory specified for the scheduled process.  See “Pa
name Expansion” on page 4-36.

Privileges

NightSim grants the P_RTIME, P_CPUBIAS, and P_TSHAR privileges to target
processors automatically, except when scheduling a process under the Nigh
debugger (see “Debug” on page 4-30). Additionally, users may specify other p
leges needed by their target processes as long as the user or target process is
to them (see “Privileges” on page 2-6 for more details).

NightSim queries the target system to determine the set of privileges to whic
user or target process is entitled.

Select...

Brings up the Select Process Privileges dialog to allow the user to spec
ify desired privileges.

See “Select Process Privileges” on page 4-35 for more information.

CPU Bias

This panel of check buttons allows you to select the processor or processo
which the program can be scheduled. Click on one or more buttons, where the
0 represents the first logical CPU, 1 represents the second, and so on. To select
CPUs on your system, click on the All CPUs button.

NOTE

If the CPU Bias of a process is changed while the scheduler is
running, the Monitor window will not reflect the updated value
until the next Monitor window update after the process runs
again.

NOTE

You cannot change the CPU bias of /idle  or /spare  while the
scheduler is active because they are not real processes.  You must
either add a new process with the desired CPU bias, or make the
change while the scheduler is inactive.  See “How Is Idle Time
Monitored?” on page 5-4 and “How Is Spare Time Monitored?”
on page 5-4 for more information.

Sched Policy

This panel of radio buttons allows you to select the POSIX scheduling policy fo
specified program. The options are as follows: the FIFO (first–in–first–o
scheduling policy, the round–robin scheduling policy, and the other (time-shar
scheduling policy. 
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For a full description of the behavior of processes that are scheduled unde
respective policies, refer to the “Process Scheduling and Management” chap
the PowerMAX OS Programming Guide.

Priority

The range of priority values that you can enter is governed by the scheduling p
specified. You can determine the allowable range of priorities associated with 
policy (FIFO, Round-Robin, or Other) by invoking the run(1)  command from the
shell and not specifying any options or arguments (see the corresponding sy
manual page for an explanation of this command). Higher numerical va
correspond to more favorable scheduling priorities.

NightSim displays the range of priority values that you can enter next to
Prior ity field.

For complete information on scheduling policies and priorities, refer to the “Pro
Scheduling and Management” chapter of the PowerMAX OS Programming Guide.

NOTE

If the Priority of a process is changed while the scheduler is run-
ning, the Monitor window will not reflect the updated value until
the next Monitor window update after the process runs again.

Parameter

This field allows you to pass an integer value to a process that is scheduled
frequency–based scheduler. The value must be a 32-bit decimal value. The def
no value. The process can retrieve this value by using the sched_fbsqry(3rt)
library routine.

Soft Ovrn. Limit

This field allows you to specify a consecutive overrun limit count that this proc
will tolerate and have processed as soft overruns by the kernel.  Soft overruns are
catastrophic failures only if the process reaches its limit on the number of soft o
runs tolerated.  This soft overrun limit defaults to 0 for each process.

Overrun

This check button allows you to indicate whether or not the selected sched
should be stopped in the event that the specified program causes a frame overrun.
Turn this button on if you wish the scheduler to be stopped. 

NOTE

This may useful in conjunction with scheduling a process under
the NightView debugger, making it easier to stop a scheduled pro-
cess at the source of an overrun and determine the activity which
caused the overrun to occur.
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Starting cycle

This field allows you to specify the first minor cycle in which the specified program
is to be wakened in each major frame. Enter a number ranging from zero to the tot
number of minor cycles per frame minus one. (The total number of minor cycles
frame is defined when you use the Scheduler Configuration Area to configu
scheduler.  See “Using the Scheduler Configuration Area” on page 4-21 for det

NightSim displays the range of starting cycle values that you can enter next t
Starting cycle field.

NOTE

You must enter a starting cycle of zero for unscheduled processes
(for an explanation of unscheduled processes, see Chapter 5,
“Using the Monitor Window,” and the section entitled “Monitor-
ing Unscheduled Processes”).

Period

This field allows you to establish the frequency with which the specified progra
to be wakened in each major frame. A period of one indicates that the specifie
program is to be wakened every minor cycle; a period of two indicates that it is to be
wakened once every two minor cycles, a period of three once every three m
cycles, and so on. Enter the number of minor cycles representing the frequenc
which you wish the program to be wakened. This number can range from zero 
number of minor cycles that compose a frame on the scheduler. (The total num
minor cycles per frame is defined when you use the Scheduler Configuration 
to configure a scheduler.  See “Using the Scheduler Configuration Area” on p
4-21 for details.) 

NightSim displays the range of period values that you can enter next to the Period
field.

NOTE

You must enter a period of zero for unscheduled processes (for an
explanation of unscheduled processes, see Chapter 5, “Using the
Monitor Window,” and the section entitled “Monitoring Unsched-
uled Processes”).   

After you have entered the scheduling parameters for a specified program, you may
the changes and close the Edit Process dialog, apply the changes without closing th
dialog, add another program to the scheduler, reset the contents of the dialog to its
state, cancel the changes and close the dialog, or display help for the dialog. 
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NOTE

If the Period of a process is changed while the scheduler is run-
ning, the Monitor window will not reflect the updated value until
the next Monitor window update after the process runs again.

Select Process Privileges 4

The Select Process Privileges dialog allows the user to specify Privileges (see
“Privileges” on page 4-32) needed by the target process as long as the user or targ
cess is entitled to them  (see “Privileges” on page 2-6 for more details).

Figure 4-24.  Select Process Privileges Dialog

The user may select the Clear/Set Max Privileges checkbox to select all or none o
the privileges to which the user or target process is entitled.  These include:

- the combined set of all privileges specified by the roles assigned to the user
on the target system (see adminuser(1)  and adminrole(1)  for more
information)

- the fixed privileges associated with the executable process on the target
system (see filepriv(1)  for more information)

The user may select the All Privileges  checkbox only if the user is entitled to all privi
leges on the target system.

If the Scheduler is On-Line (see “On-Line/Off-Line Operation” on page 4-5), the us
may select from the set of privileges to which the user or target process is entitled.
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If the Scheduler is Off-Line, the user may select from all privileges listed in the Select
Process Privileges  dialog.  Verification of the allowable privileges will occur whe
the Scheduler transitions to an On-Line mode of operation.

NOTE

If the user has selected to run the process under NightView (see
“Debug” on page 4-30), it is the responsibiliy of the user to ensure
that appropriate privileges are granted to the NightView session
(see “Privileges” on page 2-6 for details).  Most notably, the
P_RTIME privilege is required.  Attempts to schedule a process
under the NightView debugger without the P_RTIME privilege
will fail.

Pathname Expansion 4

When entering the Program Name, Input File, or Output File in the Edit Process
window (see “The Edit Button” on page 4-26), the user can make use of the follo
conventions:

- if the pathname begins with / , it is assumed to be fully rooted

- if the pathname begins with . , .. , or a simple file or directory name, it is
assumed to be relative to the path in the Working Directory field

- if the pathname begins with ~, it is interpreted according to the values of
the following environment variables on the NightSim host:

- ~, ~/ , or ~user (where user is the username of the user running
NightSim), the login directory of the user is substituted

- ~otheruser (where othername is a user other than the user running
NightSim), the login directory of otheruser is substituted

- ~+, the value of $PWD on the NightSim host is substituted.

- ~-, the value if $OLDPWD on the NightSim host is substituted

- if any part of the pathname contains an environment variable reference of
the form $name, the value of $name on the NightSim host is substituted

The pathnames will be expanded and substitutions made at the time the Apply or Add
button is pressed.

The Delete Button 4

Delete . . . 

This button allows you to delete FBS-scheduled processes from a scheduler. If you se
more than one process in the list, all of them are deleted when you click on this butt
the scheduler is active when you click on this button, NightSim displays the warning
log in Figure 4-25.
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Figure 4-25.  Delete Process Dialog: Active Scheduler

You may press the Yes button to kill the selected processes after deleting them from
frequency-based scheduler.  You may also press the No button to delete the processe
from the scheduler but allow them to continue executing or press Cancel  to abort the
action.

If the scheduler is inactive when you click on this button, NightSim displays the di
that Figure 4-26 presents.

Figure 4-26.  Delete Process Dialog:  Inactive Scheduler

You may press OK to delete the processes from the scheduler or Cancel to cancel the
operation.

The Filter Button 4

Filter . . . 

This button allows you to specify the FBS-scheduled processes that you wish to b
displayed in the the Process Scheduling Area (see “Using the Process Scheduling
on page 4-25) of the Scheduler window.  When you click on this button, NightSim dis
plays the dialog that Figure 4-27 presents.
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Figure 4-27.  Filter Process List Dialog  

Filter Process List

This list contains all of the processes that are scheduled on the scheduler an
cates whether or not they are visible in the list presented in the Process Sche
Area of the Scheduler window (see “Using the Process Scheduling Area” on pa
4-25 for details). You may use the mouse to select the process or processes th
wish to show or hide and then click on the Show or Hide button as desired.

You may also use a combination of the following items to specify which processes
wish to Show or Hide:

FPID

You may specify the unique frequency-based scheduler process identifier for a pro-
cess that you wish to Show or Hide.

Program Name

You may specify the name of the process that you wish to Show or Hide.  Enter a
full or relative pathname.  The pathname must be valid on the target system to which
this process is assigned.

CPU Mask

This panel of check buttons allows you to Show  or Hide processes which are
scheduled on the specified processor or processors. Click on one or more bu
where the label 0 represents the first logical CPU, 1 represents the second, and s
on.  To select all CPUs on your system, click on the All button.

If an FBS-scheduled process with the specified identifier(s) does not exist, Nigh
reports an error. If more than one FBS-scheduled process with the specified identi
exists, all such processes are shown or hidden.

Show

Lists in the Process Scheduling Area (see “Using the Process Scheduling Are
page 4-25) of the Scheduler window those processes either selected in the Filter
Process List or specified using FPID, Program Name, or CPU Mask .
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Hide

Removes from the Process Scheduling Area (see “Using the Process Sche
Area” on page 4-25) of the Scheduler window those processes either selected
the Filter Process List  or specified using FPID , Program Name, or CPU
Mask .

The Refresh Button 4

Refresh 

This button is enabled only when the Scheduler window is active. Clicking on this but-
ton updates the scheduler and process information in the window. If a process term
for example, it will remain in the process list until the Refresh button is clicked, at which
time it will be removed.

Using the Scheduler Control Area 4

The Scheduler Control Area is a part of the Scheduler window (see “Introduction to the
Scheduler Window” on page 4-8).

The Scheduler Control Area allows you to create and remove a frequency-based sched
uler. It contains two push buttons that you use to perform these functions: the Set up but-
ton and the Remove button.  

Figure 4-28.  Scheduler Window - Scheduler Control Area
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The Scheduler Control Area also contains an icon that indicates the current state 
Scheduler window. 

Figure 4-3 illustrates a Scheduler window that is in the active state.

The Set up button is enabled only when the window is in the inactive state. When you
click on the Set up button, NightSim carries out the following actions:

• Transitions the NightSim Scheduler to an On-Line mode of operation, if
the NightSim Scheduler is operating in an O ff -L i ne  mode (see
“On-Line/Off-Line Operation” on page 4-5).  The state of each target on
which processes are scheduled, the existence and execute permissions of
each scheduled program, and the existence and read permissions for any
input files required on each target is verified.

• Determines whether there is an existing scheduler that is associated with
the same key as that entered in the current window.

If an active scheduler with the same scheduler key as the key you selected
already exists on one or more target systems to which you assigned pro-
cesses, NightSim displays the dialog that Figure 4-29 presents.

Figure 4-29.  Scheduler Exists Dialog

When the window is inactive, NightSim shows an
unplugged connection.

When the window is active, it shows a plugged
connection.
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You have two main choices:

- Work with the existing FBS, in which case the active FBS’s configu-
ration will appear in the Scheduler window in place of the current
configuration.

or

- Replace the existing FBS with a new scheduler based on the configu-
ration in the window.

If you decide to replace the existing FBS, you then need to decide what t
with the processes running under the old FBS.  Figure 4-25 is presented i
case.

You may also press the Cancel button to abort this action.

• Creates a scheduler that is configured according to the parameters specified
in the Scheduler Configuration Area of the window (see “Using the Sched-
uler Configuration Area” on page 4-21 for details)

• Schedules the processes that are listed in the Process Scheduling Area of
the window and starts them running (see “Using the Process Scheduling
Area” on page 4-25 for details). Programs will run up to the first fbswait
system call.

• If a distributed timing source is selected but not already in use, and is found
to be already registered, NightSim automatically re-registers the device for
the current scheduler.

• Attaches the timing source to the scheduler

• Enables the Start button in the Simulation Control Area 

Initially, the simulation is stopped. For an explanation of the Simulation
Control Area, see “Using the Simulation Control Area” on page 4-43. 

• Disables the Set up button and enables the Remove button

• Places the window in the active state and changes the state icon and title
bar accordingly 

The Remove button is enabled only when the window is in the active state. When you
click on the Remove button, NightSim carries out the following actions:

• Displays the dialog that Figure 4-30 presents. 

Figure 4-30.  Remove Scheduler Dialog
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You may press Yes  to kill the processes that are currently scheduled on the sc
uler, No to remove the processes from the scheduler but allow them to continue
cuting, or Cancel to abort the action.

• Stops the simulation if it is running

• If a real-time clock is being used as the timing source, and the scheduler is
running, stops the clock.

• Detaches the timing source from the scheduler or disables end-of-cycle
scheduling

• Removes all processes that are currently scheduled on the scheduler from it
and either terminates them or allows them to continue executing in
accordance with the selections made in response to the dialog presented in
Figure 4-30

• Removes the scheduler from the system

• Disables the Start, Stop, and Resume buttons in the Simulation Control
Area 

For an explanation of the Simulation Control Area, see “Using the Simula-
tion Control Area” on page 4-43

• Enables the Set up button and disables the Remove button

• Places the window in the inactive state and changes the state icon and title
bar accordingly
4-42
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Using the Simulation Control Area 4

The Simulation Control Area is a part of the Scheduler window (see “Introduction to the
Scheduler Window” on page 4-8).

The Simulation Control Area allows you to start, stop, and resume a simulation. It 
tains three push buttons that you use to perform these functions: the Start  button, the
Stop button, and the Resume button.  

Figure 4-31.  Scheduler Window - Simulation Control Area

The Simulation Control Area also contains an icon that indicates whether the simulat
stopped or running. 

Figure 4-3 illustrates a Scheduler window in which the simulation is running.

The Start button is enabled only when the simulation is stopped. When you click on
Start button, NightSim carries out the following actions:

• Attaches the timing source to the scheduler if not already attached or if the
timing source has been changed

• If a real-time clock is being used as the timing source, sets the clock period
in accordance with the value entered in the Clock period  field in the
Scheduler Configuration Area (see p. 4-24 for information on this field)

• Starts the simulation with the values of the minor cycle, major frame, and
overrun counts set to zero

The Stop button is enabled when the simulation is running. When you click on the Stop
button, NightSim stops the simulation.  When the simulation is stopped, the timing so

When the simulation is stopped, NightSim dis-
plays a stop sign. 

When the simulation is running, NightSim dis-
plays a circle containing the word GO. 
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is not detached from the scheduler, but the Timing source and Clock period fields in
the Scheduler Configuration Area of the Scheduler window are enabled (see pp. 4-2
and 4-24, respectively, for information on these fields). You may wish to change the
ing source, and, if the timing source is a real-time clock, you may wish to change the 
period.

NOTE 

If you change the timing source, the previously specified timing
source is detached from the scheduler when you click on the
Start or Resume button to start or resume the simulation.

While the simulation is stopped, you may also wish to change one or more of the pa
ters with which you have scheduled a process on the scheduler.

Although you can also change the parameters with which a process has been sch
while the scheduler is running, it is not recommended that you do so.  Resched
requires processor time.  As a result, other processes that are currently scheduled
frequency-based scheduler may experience frame overruns.  If you have indicated as
such, the scheduler will halt on a frame overrun but can be resumed.

The Resume button is enabled when the simulation has been running but is curre
stopped.  When you click on the Resume button, NightSim restarts the simulation wit
the values of the minor cycle, major frame, and overrun counts the same as they wer
when you stopped the simulation.
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Using the Run Status Area 4

The Run Status Area is a part of the Scheduler window (see “Introduction to the Sched
uler Window” on page 4-8).

The Run Status Area shows the number of the current major Frame and the current minor
Cycle for the simulation running on the scheduler.  

Figure 4-32.  Scheduler Window - Run Status Area

This area also contains the following two configurable items:

On Target 

This option menu allows you to select which target system supplies the frame num-
ber and minor cycle count.  This allows you to see each target’s frame and cy
counts and determine if the schedulers are out of sync.  It also allows you to a
the work of supplying this information to a target system that may not be
time-critical as other systems.

Rate

This field allows you to specify the frequency with which the frame and cy
counts in the Run Status Area are to be updated. Enter the number of seco
occur between updates. The minimum value that you may specify is .01 secon
maximum is 100 seconds.  The default value is 1.0 second.

Figure 4-3 and Figure 4-32 illustrate the Run Status Area for a Scheduler window that is
in the active state. 
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Chapter 5Using the Monitor Window

5
6
7

This chapter describes the performance monitor and explains how to monitor FBS-
scheduled processes, a processor’s idle and spare time, and unscheduled processes. 
introduces the components of NightSim’s Monitor window and describes the use of eac
component.

Understanding the Performance Monitor 5

The performance monitor is a mechanism that enables you to monitor FBS–scheduled pro-
cesses’ utilization of a CPU.

The performance monitor provides you with the ability to:

• Obtain performance monitor values by process or processor

• Start and stop performance monitoring by process

• Clear performance monitor values by processor

You also have the ability to set the timing mode under which the performance monitor i
to run. You can select one of two modes: one that includes time spent servicing inte
in performance monitor timing values and one that excludes time spent serv
interrupts from those values.

When the performance monitor timing mode is set to include interrupt time, a proc
user and system times will total the elapsed time that accrues when the process
currently running process. This elapsed time includes time spent servicing interrupt
performing context switches. Time spent servicing interrupts is added to the proc
system time. Time spent switching to a new process is included in the new proc
system time.

When the performance monitor timing mode is set to exclude interrupt time, a proc
user and system times will total the time that accrues when the process is the cur
running process. This time excludes time spent servicing interrupts, but it includes
spent performing context switches. Time spent switching to a new process is includ
the new process’s system time.

What Values Are Monitored? 5

The performance monitor keeps track of the time that a process spends running from
time that it is wakened by a frequency–based scheduler until it calls fbswait . Time is
measured in microseconds. One instance of a process’s being wakened by a sche
referred to as an iteration or a cycle. Performance monitor values for FBS–scheduled
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processes are reported both in terms of cycles, or iterations, and in terms of major frames.
They reflect what has happened since the last time that performance monitor value
cleared and performance monitoring was enabled.

When performance monitoring is enabled for an FBS–scheduled process, NightSim
maintains the following values for each process:

Process Parameters

Target The system on which this process is running

FPID The process’s unique frequency-based scheduler identifier

PID The process’s process identification number

Name The process’s name

Priority The process’s scheduling priority

Starting Cycle The number of the first minor cycle in which the process is
to be wakened in each frame

Period The frequency with which the process is to be wakened
each major frame

CPU Mask The process’s CPU mask

Interrupt Time Inclusion Indicates whether time spent processing interrupts
included in performance monitor timing values

General Statistics

Total iterations, cycles The number of times that the process has been waken
the scheduler 

Last time The amount of time that the process has spent running 
the last time that it has been wakened by the scheduler u
it has called fbswait  

Total time The total amount of time that the process has spent run
in all cycles 

Average time The average amount of time that the process has s
running in all cycles, or iterations. This value is obtained by
dividing the value reported in the Total Time column by th
value reported in the Iterations column.

Number of overruns The number of times that the process has caused a frame
overrun 

Percent of period used This value is maintained only if the timing source for
frequency-based scheduler on which the process is
scheduled is a real-time clock. It is obtained by dividing t
value reported in the Average Time column by the amou
of time that is available to the process. The amount of ti
5-2
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available to the process is calculated from its period and the
length of a clock cycle.

Minimum Values

Minimum cycle time The least amount of time that the process has spent run
in a cycle

Minimum cycle frame The number of the major frame in which the minimum cycle
time has occurred

Minimum cycle cycle The number of the minor cycle in which the minimum cycle
time has occurred

Minimum frame time The least amount of time that the process has spent run
during a major frame

Minimum frame frame The number of the major frame in which the minimum
frame time has occurred

Maximum Values

Maximum cycle time The greatest amount of time that the process has s
running in a cycle

Maximum cycle frame The number of the major frame in which the maximum
cycle time has occurred

Maximum cycle cycle The number of the minor cycle in which the maximum cycle
time has occurred

Maximum frame time The greatest amount of time that the process has 
running during a major frame

Maximum frame frame The number of the major frame in which the maximum
frame time has occurred

Monitoring Idle and Spare Time 5

The performance monitor provides you with the capability of monitoring a processor
idle and spare time. Idle time refers to the time that the CPU is not busy. Spare ti
composed of the following:

• Idle time

• CPU time of processes that are not scheduled on a frequency–based sched-
uler

• CPU time of FBS–scheduled processes for which performance monitoring
has not been enabled 

It is important to note that you may monitor a processor’s spare time at the same tim
you are monitoring its idle time. By monitoring a processor’s idle time, you can determ
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the amount of CPU time that is available to be allocated to additional processe
subtracting the values obtained for idle time from those obtained for spare time, yo
obtain an estimate of the amount of CPU time that is being allocated to processes th
not part of a simulation. You may be able to increase the number of tasks include
simulation that you are running or run additional simulations.

Procedures for monitoring idle and spare time are described in “How Is Idle Time M
tored?” and “How Is Spare Time Monitored?”

How Is Idle Time Monitored? 5

You can monitor a particular processor’s idle time if you add the process /idle  to a
frequency–based scheduler and schedule it on the desired processor for a particulatarget
system. You can schedule /idle  for any or all targets.  You can also monitor idle time f
a number of different processors by adding /idle  to a selected frequency–based sched
uler more than once and scheduling it on a different processor each time. Further
you can add /idle  to more than one frequency–based scheduler.  

NOTE

It is important to note that you can schedule /idle  on a particu-
lar processor for a particular target only once.  This is a system-
wide restriction.  Only one user per processor per target may
schedule /idle  or /spare .

To add /idle  to a frequency–based scheduler, use the Process Scheduling Area 
Scheduler window (see “Using the Process Scheduling Area” on page 4-25 for deta
For an explanation of the procedures for adding a program to a scheduler, re
Chapter 4, “Using the Scheduler Window.”

When you use NightSim to add /idle  to a frequency–based scheduler, the only param
ter that you may specify is the CPU mask. The CPU mask for /idle  must specify only
one CPU. The default scheduling priority is zero. The starting base cycle is zero, an
period is one. /idle  will be scheduled every minor cycle, starting with the first minor
cycle in each major frame.

You can view scheduling information for /idle  in the same way that you view it for
other FBS–scheduled processes––in the Process Scheduling Area of the Scheduler win-
dow (see “Using the Process Scheduling Area” on page 4-25 for details). For an illu
tion that shows this area, refer to Figure 4-3 in Chapter 4, “Using the Scheduler 
dow.”.

How Is Spare Time Monitored? 5

You can monitor a processor’s spare time by adding the process /spare  to a selected
frequency–based scheduler and scheduling it on the desired processor for a particular tar-
get. You can schedule /spare  for any or all targets as well.  As in the case of /idle ,
you can monitor spare time for a number of different processors by adding /spare  to a
selected frequency–based scheduler more than once and by scheduling it on a di
5-4
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processor each time. You can also add /spare  to more than one frequency–based sche
uler. 

NOTE

It is important to note that you can schedule /spare  on a particu-
lar processor for a particular target only once.  This is a system-
wide restriction.  Only one user per processor per target may
schedule /idle  or /spare .

When you add /spare  to a frequency–based scheduler, the only parameter that you 
specify is the CPU mask. The CPU mask for /spare  must specify only one CPU. The
default scheduling priority is zero. The starting base cycle is zero, and the period is
/spare  will be scheduled every minor cycle, starting with the first minor cycle in each
major frame.

You can view scheduling information for /spare  in the same way that you view it for
other FBS–scheduled processes––in the Process Scheduling Area of the Scheduler win-
dow (see “Using the Process Scheduling Area” on page 4-25 for details). For an illu
tion that shows this area, refer to Figure 4-3 in Chapter 4, “Using the Scheduler 
dow.”. 

Monitoring Unscheduled Processes 5

The performance monitor provides you with the additional capability of monitoring th
performance of unscheduled processes. Unscheduled processes are those that
wakened by the scheduler and do not call fbswait ; they are not scheduled to run at 
certain frequency. To be able to obtain performance monitor values for such processes
you must first add them to a frequency–based scheduler and specify a starting base cycl
of zero and a period of zero. The other scheduling parameters that you must spe
include the process’s scheduling priority and the CPU on which it is to be scheduled
can optionally specify a decimal value to be passed to a process that is schedule
frequency–based scheduler. The Halt FBS on frame overrun flag does not apply to
an unscheduled process (see “Overrun” on page 4-33).

You can add unscheduled processes to a frequency–based scheduler by using the 
Scheduling Area of the Scheduler window (see “Using the Process Scheduling Area” 
page 4-25 for details). For an explanation of the procedures for adding a program
scheduler, refer to Chapter 4, “Using the Scheduler Window.”

You can view scheduling information for unscheduled processes in the same way th
view it for other FBS–scheduled processes––in the Process Scheduling Area o
Scheduler window (see “Using the Process Scheduling Area” on page 4-25 for deta
For an illustration that shows this area, refer to Figure 4-3 in Chapter 4, “Using the Sc
uler Window.”.
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The performance monitor values that are maintained for unscheduled processes inc
the following:

• Last time

• Total time

• Minimum frame time and the number of the frame in which it occurred

• Maximum frame time and the number of the frame in which it occurred 

You can obtain these values if you enable performance monitoring for the proce
Procedures for enabling performance monitoring and retrieving performance monitor
values are described in detail in “The Monitor Menu” on page 5-10.
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Introduction to the Monitor Window 5

The Monitor window allows you to start and stop performance monitoring on FBS-
scheduled processes scheduled on one or more processors, clear performance monitor
values for all FBS-scheduled processes scheduled on one or more processors, and
performance monitor values for selected FBS-scheduled processes.

The Monitor window consists of the following components:

• Menu Bar

• Status Area

• Output Area

• Output Control Area

Figure 5-1 identifies the location of each of these components in the Monitor window.
Note that this window contains sample data associated with a scheduler that exists 
system.

Figure 5-1.  Sample Monitor Window

Procedures for using each component of the Monitor window are described in the
sections that follow.

Menu 
Bar

Status 
Area

Output 
Area

Output 
Control 

Area
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The Monitor Window menu bar is a part of the Monitor window (see “Introduction to
the Monitor Window” on page 5-7).

The Monitor Window menu bar provides access to the following menus: 

• NightSim 

• Monitor 

• Output 

• View 

• Help 

Each menu is described in the sections that follow.

The NightSim Menu 5

The NightSim menu appears on the Monitor window menu bar (see “Using the Monito
Window Menu Bar” on page 5-8).

The NightSim menu on the Monitor Window contains commands related to the glob
operation of NightSim.  Figure 5-2 presents this menu.

Figure 5-2.  NightSim Menu

Descriptions of the options on the NightSim menu follow.

Create Scheduler Window

This option allows you to create a new Scheduler window.  If this option is
selected from a Monitor window which is associated with an existing schedul
the new Scheduler window is created as an active window and all information
associated with the Monitor window, including the target and scheduler key, is
copied to this new Scheduler window.  

Create Monitor Window

This option allows you to create a new Monitor window. The new window will not
be associated with a particular frequency-based scheduler.
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Duplicate Window

This option allows you to create a new Monitor window with the same configura-
tion as that of the Monitor window from which this option was selected. Note th
if performance monitor values are currently being logged to one or more files, 
new Monitor window will not be associated with those files.

Close Window

This option allows you to close the current Monitor window. 

If performance monitor values are being logged to a file, the dialog that appear
Figure 5-3 is presented. NightSim requires that you close this file before procee

 

Figure 5-3.  Stop Logging Dialog

Press OK to stop logging and close the file, Cancel to abort the requested action
and continue logging, or display Help related to the dialog.

If the window from which you select Close Window is the only window that you
have open, NightSim displays the warning dialog that Figure 4-8 presents.

Exit

This option allows you to exit NightSim. If you have open Scheduler windows
that are untitled and contain unsaved changes, NightSim displays the warning d
that Figure 4-5 presents (see p. 4-11). In each case, you may save the change
the window without saving the changes, cancel the close operation, or display
related to the dialog. If you click on the Yes button to save the changes, NightSim
displays the file selection dialog that Figure 4-6 presents (see p. 4-11).

If you have open a Scheduler window that is associated with a configuration fil
name and contains unsaved changes, NightSim displays the warning dialog
Figure 4-7 presents. If you click on the Yes button, the changes are saved in the fi
associated with the window.

The warning dialogs are displayed for each window that contains unsaved cha

If performance monitor values are being logged to one or more files, NightSim d
plays the warning dialog in Figure 5-3 (see p. 5-9). You may confirm that you w
to stop logging and close the file, continue to keep the window open, or display
related to the dialog.
5-9
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The Monitor Menu 5

The Monitor menu appears on the Monitor window menu bar (see “Using the Monito
Window Menu Bar” on page 5-8).

The Monitor menu contains general commands related to performance monito
Figure 5-4 presents this menu.

Figure 5-4.  Monitor Menu

Descriptions of the options on the Monitor menu follow.

Select Active Scheduler . . . 

This option allows you to associate the current Monitor window with a frequency-
based scheduler active on a given target system. When you select this option, Night-
Sim displays Figure 4-10, “Select Active Scheduler Dialog,” (see p. 4-14
Chapter 4 for an explanation of this dialog). 

This dialog provides a list of the active schedulers for the system designated b
Target  field.  The Target  defaults to your local SBC and the list contains th
active schedulers running on that particular system.  For instance, Figure 4-10
the two schedulers currently running on the target amber2 .

You may change the Target either by using the drop-down list (which lists the ta
gets in your cluster) or by typing the name of the target system into the text field
provided.  Entering an item in this field will populate the list with the active sch
ulers on the specified target.

You may select a scheduler from the list that the dialog displays, or you may us
Scheduler Key  text field to enter the numeric key that is associated with the
desired scheduler. The key can be any positive integer value. Whether you 
from the list or enter a key, the selected scheduler must previously have 
configured, and you must have at least read permission for it; otherwise, Nigh
reports an error.

Once you select a scheduler, NightSim will determine whether that schedul
attached to a distributed timing device.  If so, NightSim will try to locate schedulers
on any other targets that have the same key and are attached to the same dist
timing device using the fbsinfo_rdev(3rt)  service.  All such schedulers
5-10
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to the user.

If you successfully select an existing scheduler, the Monitor window is associated
with that scheduler.

If performance monitor values are being logged to one or more files, NightSim a
you if you wish to stop the logging and close the files using the dialog that app
in Figure 5-3.  You may confirm that you wish to stop logging and close the 
continue to keep the window open, or display help related to the dialog.  If the 
dow from which you select Select Active Scheduler . . . is the only window
that you have open, NightSim displays the warning dialog in Figure 4-8.

Associate Scheduler Window . . .

This dialog box allows you to associate a Monitor window with an existing sched-
uler.  The dialog lists the scheduler key and the target systems to which processes
are assigned for each Scheduler window in the current NightSim session.  Sele
one of these schedulers by clicking on it and pressing OK , or press Cancel to close
the dialog and leave the Monitor window unchanged.

Figure 5-5.  Select Associated Scheduler Window Dialog

Select Target and Key . . .

This dialog allows you to associate a Monitor window with a scheduler by specify-
ing the Target System  where the scheduler resides and its Scheduler Key.
The scheduler need not already exist.  If it does not exist but the scheduler is c
in this session of NightSim, the Monitor window will automatically start monitor-
ing that scheduler when the scheduler is created and started by NightSim.
5-11
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Figure 5-6.  Select Target System and Key Dialog

Enable/Disable Monitoring . . . 

This option allows you to enable or disable performance monitoring for one or m
processes that are scheduled on the selected scheduler.  By default, perfor
monitoring is enabled for all FBS-scheduled processes. 

When you select this option, NightSim displays the selection dialog that Figure
presents.

Figure 5-7.  Enable/Disable Monitoring Dialog

Enable/Disable Monitoring List

This list contains all of the processes that are scheduled on the scheduler an
cates whether or not performance monitoring is currently enabled for each pro
You may use the mouse to select the process or processes for which you w
enable or disable performance monitoring and then click on the Enable or Dis-
able button as desired.

You may also use a combination of the following items to specify those processe
which you wish performance monitoring enabled or disabled:
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FPID:

You may specify the unique frequency-based scheduler process identifier of a pro-
cess for which you wish performance monitoring enabled or disabled.

Program Name:

You may specify the name of the process for which you wish performance mon
ing enabled or disabled.  Enter a full or relative pathname.  The pathname mu
valid on the target system to which this process is assigned.

CPU Mask:

This panel of check buttons allows you to Enable or Disable performance moni-
toring for processes that are scheduled on the specified processor or proce
Click on one or more buttons, where the label 0 represents the first logical CPU, 1
represents the second, and so on.  To select all CPUs on your system, click 
All button.

If an FBS-scheduled process with the specified identifier(s) does not exist, Nigh
reports an error. If more than one FBS-scheduled process with the specified identi
exists, all such processes are shown or hidden.

Enable

Enables performance monitoring for those processes either selected i
Enable/Disable Monitoring List or specified using FPID, Program Name,
or CPU Mask.

Disable

Disables performance monitoring for those processes either selected in
Enable/Disable Monitoring List or specified using FPID, Program Name,
or CPU Mask.

Include Interrupt Time

This item allows you set the timing mode under which the performance monitor is t
run, indicating that time spent processing interrupts is to be included in perfor-
mance monitor timing values.  This is a system-wide setting that affects all p
cesses on the target systems that have processes attached to the specified schedu

This status may be displayed by selecting the Interrupt Time Inclusion check-
box in the Custom Display dialog from the View menu (see Figure 5-12 on pag
5-17).  The Output Area in the Monitor window will then report this status for each
process (see “Using the Output Area” on page 5-24 for related information).

Exclude Interrupt Time

This item allows you to set the timing mode under which the performance monitor i
to run, indicating that time spent processing interrupts is to be excluded from per-
formance monitor timing values.  This is a system-wide setting that affects all p
cesses on the target systems that have processes attached to the specified schedu

This status may be displayed by selecting the Interrupt Time Inclusion check-
box in the Custom Display dialog from the View menu (see Figure 5-12 on pag
5-13



NightSim User’s Guide

d CPUs

nts.

or-

which
re
To

 help

r

ts this

or dis-
5-17).  The Output Area in the Monitor window will then report this status for each
process (see “Using the Output Area” on page 5-24 for related information).

Clear Performance Values . . . 

This option allows you to clear performance monitor values for all FBS-scheduled
processes on one or more processors.  Note that values are cleared for selecte
on all target systems that have processes attached to the specified scheduler.

When you select this option, NightSim displays the dialog that Figure 5-8 prese

Figure 5-8.  Clear Performance Monitor Values Dialog

By default, All CPUs is selected, so that you may conveniently clear all perf
mance monitor values for all CPUs by simply pressing Enter or clicking OK.

You use the panel of check buttons to select the processor or processors for 
you wish to clear performance monitor values. Click on one or more buttons, whe
the label 0 represents the first logical CPU, 1 represents the second, and so on. 
select all CPUs on your system, click on the All CPUs  button. After selecting the
processor(s), you may apply your selection, cancel the operation, or display
related to the dialog. 

The Output Menu 5

The Output  menu appears on the Monitor window menu bar (see “Using the Monito
Window Menu Bar” on page 5-8).

The Output menu controls where performance data is to be sent.  Figure 5-9 presen
menu.

Figure 5-9.  Output Menu

A checkmark appears next to an item if it is enabled.  The two items can be enabled 
abled independently.  Descriptions of these options follow.
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To Screen

This toggle button allows you to indicate whether or not performance monito
values are to be displayed in the Output Area of the Monitor window (see “Using
the Output Area” on page 5-24 for related information).

To Text File . . . 

This option allows you to (1) specify the name of a text file in which you wish per-
formance monitor values to be saved and (2) specify the types of values to be sa
When you select this option, NightSim displays the selection dialog that Figure
presents.

Figure 5-10.  Save to Text File Dialog

To select the file in which values are to be saved, use the directory text area
mask area, list of directories, list of files, and file selection text area as approp
To specify the types of values to be saved, use the Fields to output option menu
that Figure 5-11 presents.

Figure 5-11.  Fields to Output Option Menu
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Descriptions of the options contained in the Fields to output option menu follow.  

Summary Fields

This option specifies the following types of values: target system, process
parameters (FPID, program name, and CPU mask) and general statist
Refer to “What Values Are Monitored?” on page 5-1 for a complete desc
tion of all types of performance monitor values.

Minimum Fields

This option specifies the following types of values: target system, process
parameters (FPID, program name, and CPU mask), general statistics (itera-
tions), and minimum values. Refer to “What Values Are Monitored?” on pa
5-1 for a complete description of all types of performance monitor values.

Maximum Fields

This option specifies the following types of values: target system, process
parameters (FPID, program name, and CPU mask), general statistics (itera-
tions), and maximum values. Refer to “What Values Are Monitored?” on pa
5-1 for a complete description of all types of performance monitor values.

All Fields

This option specifies all types of values: target system, process scheduling
parameters, general statistics, minimum values, and maximum values. R
to “What Values Are Monitored?” on page 5-1 for a complete description
all types of performance monitor values.

Custom . . . 

This option allows you to select any of the types of values that the perfor-
mance monitor facility maintains.

When you select this option, NightSim displays the dialog that Figure 5
presents.
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Figure 5-12.  Custom Display Dialog Box

You use the panels of check buttons to select the types of performance moni-
tor values that you wish to save. Click on one or more buttons as des
After you have selected the types of values that you wish to save, you 
apply the selections and close the Custom Display dialog box, cancel the
selections, or display help related to the dialog.

After selecting the file in which values are to be saved and specifying
types of values to be saved, you may save the values in the selected
search for another file, cancel the operation, or display help related to the
log. 

The View Menu 5

The View menu appears on the Monitor window menu bar (see “Using the Monitor Win
dow Menu Bar” on page 5-8).

The View menu controls output to the Monitor window.  Figure 5-13 presents this me

Figure 5-13.  View Menu

Descriptions of the options on the View menu follow.
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Select Processes. . .   

This option allows you to specify the FBS-scheduled processes whose performance
monitor values will be reported.  

Depending on the selection under the Output menu (see “The Output Menu” on
page 5-14), performance monitor values will be displayed in:

• the Output Area of the Monitor window if the “To Screen” option
is selected (see “Using the Output Area” on page 5-24 for more
information)

• a text file if the “To Text File...” option is selected

Note that performance monitoring must be enabled for a process in order for it 
shown in the Monitor window.  Performance monitoring is enabled for all pr
cesses by default.

When you choose the Select Processes . . . option, NightSim displays the dia-
log in Figure 5-14:

Figure 5-14.  Select Processes to View Dialog

Select Processes List

This list contains all of the processes that are scheduled on the schedule
indicates whether or not their performance values will be reported. You m
use the mouse to select the process or processes whose performance 
you wish to Show or Hide.

You may also use a combination of the following items to specify which proce
you wish to Show or Hide:

FPID:

You may specify the unique frequency-based scheduler process identifier for
a process whose performance values you wish to Show or Hide.
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You may specify the name of the process that you wish to Show or Hide.
Enter a full or relative pathname.  The pathname must be valid on the target
system to which this process is assigned.

CPU Mask:

This panel of check buttons allows you to Show or Hide processes which are
scheduled on the specified processor or processors. Click on one or mor
tons, where the label 0 represents the first logical CPU, 1 represents the sec-
ond, and so on.  To select all CPUs on your system, click on the All button.

If an FBS-scheduled process with the specified identifier(s) does not exist, N
Sim reports an error. If more than one FBS-scheduled process with the spe
identifier(s) exists, all such processes are shown or hidden.

Show

Reports the performance monitor values for those processes either selec
the Select Processes List or specified using FPID, Program Name, or
CPU Mask .

Hide

Refrains from reporting the performance monitor values for those proce
either selected in the Select Processes List  or specified using FPID,
Program Name, or CPU Mask .

Display Fields

This option allows you to specify the types of performance monitor values that are
to be displayed in the Output Area of the Monitor window (see “Using the Output
Area” on page 5-24 for related information). When you select this option, Night
displays the tear-off menu that Figure 5-15 presents.

Figure 5-15.  Display Fields Tear-Off Menu

Descriptions of the options contained in the Display Fields tear-off menu follow.

Summary Fields

This option specifies the following types of values: target system, process
parameters (FPID, program name, and CPU mask) and general statist
5-19
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Refer to “What Values Are Monitored?” on page 5-1 for a complete desc
tion of all types of performance monitor values.

Minimum Fields

This option specifies the following types of values: target system, process
parameters (FPID, program name, and CPU mask), general statistics (itera-
tions) and minimum values. Refer to “What Values Are Monitored?” on pa
5-1 for a complete description of all types of performance monitor values.

Maximum Fields

This option specifies the following types of values: target system, process
parameters (FPID, program name, and CPU mask), general statistics (itera-
tions) and maximum values. Refer to “What Values Are Monitored?” on pa
5-1 for a complete description of all types of performance monitor values.

All Fields

This option specifies all types of values: target system, process scheduling
parameters, general statistics, minimum values, and maximum values. R
to “What Values Are Monitored?” on page 5-1 for a complete description
all types of performance monitor values.

Custom . . . 

This option allows you to select any of the types of values that the perfor-
mance monitor facility maintains. 

When you select this option, NightSim displays the dialog that Figure 5
presents.

You use the panels of check buttons to select the types of performance moni-
tor values that you wish to display. Click on one or more buttons as des
After you have selected the types of values that you wish to display, you 
apply the selections and close the Custom Display  dialog box, apply the
selections without closing the dialog box, cancel the selections, or dis
help related to the dialog.

Sort By

This option allows you to select the primary sort key used in ordering the FBS-
scheduled processes and associated performance monitor values. (Refer to “The
Output Menu” on page 5-14 for information on specifying where these values
reported.)

When you select this option, NightSim displays the tear-off menu that Figure
presents.
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Figure 5-16.  Sort By Tear-Off Menu

You specify the type of value to be used as the primary sort key by clicking on
desired radio button. It is important to note that the first seven options are sepa
from the others. The reason is that with the first seven options, the sort order m
calculated only once. With the other options, the sort order must be recalcu
each time you query the values. As a result, the overhead associated with th
seven options is far less than that associated with the others.

The default is Target System.

Then Sort By

This option allows you to indicate the secondary sort key to be used in orderin
FBS-scheduled processes and associated performance monitor values. (Refer to
“The Output Menu” on page 5-14 for information on specifying where these va
are reported.)  The Sort By and Then Sort By options allow you to sort first on a
value such as priority and then sort again within that grouping by a value su
average time.

When you select this option, NightSim displays the tear-off menu that Figure
presents.
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Figure 5-17.  Then Sort By Tear-Off Menu

You specify the type of value to be used as the secondary sort key by clicking o
desired radio button or you may choose the first option, None, to have no second-
ary sort key.  It is important to note that the next eight options are separated fro
others. The reason is that with those eight options, the sort order must be calc
only once. With the other options, the sort order must be recalculated each tim
query the values. As a result, the overhead associated with the eight options
less than that associated with the other options.

The default is FPID.

Resolution

This option allows you to control the precision with which NightSim reports 
performance monitor timing values. When you select this option, NightSim displa
the tear-off menu that Figure 5-18 presents.

Figure 5-18.  Resolution Options
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You may specify the precision in microseconds, tens of microseconds, hundre
microseconds, milliseconds, or tens of milliseconds by clicking on the toggle bu
and choosing the desired option.

NOTE

As the values of times increase in a long-running simulation, the
resolution option value is automatically increased by NightSim in
order to avoid overflowing the display.

The Help Menu 5

The Help menu appears on the Monitor window menu bar (see “Using the Monitor Win
dow Menu Bar” on page 5-8).

The Help menu provides access to the on-line help system.  See “Getting Help” on 
3-4 for detailed information about this menu and each of its items.

Using the Status Area 5

The Status Area is a part of the Monitor window (see “Introduction to the Monitor Win-
dow” on page 5-7).

The Status Area displays information about the frequency-based scheduler with which
this Monitor window is associated. 

Figure 5-19.  Monitor Window - Status Area

It contains the following values:

Target

This field displays the target system on which the scheduler associated with th
Monitor window resides.  If this scheduler is distributed across multiple systems
cluster configuration, this is just one of the target systems; it is the system 
NightSim will query first to determine information about the scheduler.

Together with the Scheduler Key, this Target  system serves to identify the
scheduler to NightSim.

Scheduler Key

This field displays the numeric key for the scheduler with which this Monitor win-
dow is associated.
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If the frequency-based scheduler with which the Monitor window is associated is an
active scheduler, the Status Area also shows:

Frame

Current major frame of the associated frequency-based scheduler.

Cycle

Current minor cycle of the associated frequency-based scheduler.

The Status Area also contains two icons: one that indicates the current state of the 
uler and one that indicates the current state of the simulation. 

Figure 5-19 illustrates the Status Area for a Monitor window that is associated with an
active scheduler and a running simulation.

Using the Output Area 5

The Output Area is a part of the Monitor window (see “Introduction to the Monitor Win-
dow” on page 5-7).

The Output Area contains a textual display of performance monitor information.

When the scheduler is inactive, NightSim show
an unplugged connection. 

When the scheduler is active, it shows a plugge
connection.

When the simulation is stopped, NightSim dis
plays a stop sign. 

When the simulation is running, it displays a cir-
cle containing the word GO.
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Figure 5-20.  Monitor Window - Output Area

The Output Area allows you to view performance monitor values for selected FBS-
scheduled processes. It contains a scrolling list of the processes that are cur
scheduled on the frequency-based scheduler with which the Monitor  window is
associated and that have been selected for performance monitoring. You can u
horizontal and vertical scroll bars to scroll the visible contents of the area. Although
cannot edit this area of the Monitor window, you can use the mouse to select text in t
area and paste it in another window—one in which an editor is running, for example.

NOTE

If the Priority, Period , or CPU Bias mask of a process are
changed while the scheduler is running, the Monitor window will
not reflect the updated values until the next Monitor window
update after the process runs again.

For information on the commands that allow you to control the operation of the perfor-
mance monitor, refer to “The Monitor Menu” on page 5-10. For information on the co
mands that allow you to control the information that is displayed in the Output Area, 
to “The View Menu” on page 5-17.

Using the Output Control Area 5

The Output Control Area is a part of the Monitor window (see “Introduction to the Mon-
itor Window” on page 5-7).

The Output Control Area allows you to specify the frequency and precision with w
you wish performance monitor values to be updated.   Note that the selections that 
make in the Output Control Area apply both to the values displayed in the Output Ar
the Moni tor window (see “Using the Output Area” on page 5-24) and the values save
a file.  See “The Output Menu” on page 5-14 for related information.

Figure 5-21.  Monitor Window - Output Control Area

The Output Control Area contains the following text field and controls:
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Repetitive Query

This check button allows you to indicate that you wish NightSim to repeate
query performance monitor values at a rate that you specify in the Rate text field in
the Output Control Area. If this button is activated and the simulation on thefre-
quency-based scheduler associated with the Monitor window has not been started
NightSim will query the target system (designated in the Target field of the Moni-
tor window) at the specified Rate to detect when the scheduler gets started.

Note that once the scheduler is active, NightSim must query every target syst
which processes have been assigned to obtain the complete set of performanc
This may affect the performance of those target systems to some degree.

Rate

This field allows you to specify the frequency with which performance monitor
values are to be updated.  Enter the number of seconds to occur between up
The minimum value that you may specify is 0.01 second and the maximum is
seconds.  The default value is 1.0 second.

Query Now

This push button allows you to query performance monitor values immediately.

Resolution of Times

This displays the resolution of the times displayed by the performance monitor.
This resolution is controlled by the Resolution item in the View menu.  See “The
View Menu” on page 5-17 for more information.

NOTE

For long-running simulations, as times become larger, the resolu-
tion of displayed times is automatically reduced (i.e. resolution
value is increased) in order to avoid overflowing the display val-
ues.
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Appendix AConfiguration Files

This appendix discusses the format of configuration files used by NightSim as well a
automatic conversion of configuration files created by NightSim 2.4 and earlier versio

Configuration File Format 1

NightSim 2.4 and earlier versions allowed the user to save the configuration as a seq
of rtcp  commands to a file that could be run as a script in place of using NightSim. 
concept of a distributed FBS introduced in NightSim 3.2, allowing for processes to b
scheduled in a synchronized manner on more than one target computer, makes th
less desirable, as well as less efficient.  The configuration is now saved to a file wit
following format:

Scheduler <key> {
   cycles <n>;                   // cycles per frame
   tasks total <n>;              // total number of tasks allowed in scheduler
   tasks per cycle <n>;          // optional, defaults to total tasks
   permissions owner=<perms>;    // permissions, see below
   distribution <dist_kind>;     // distribution kind, see below

   timing source {
      host "<name>";             // timing-host name
      EOC ;                      // if end-of-cycle timing
      clock "<name>";            // if rtc, simple name of clock
      eti "<name>";              // if eti, simple name of eti
      other "<name>";            // full pathname of device
      clock duration <n>;        // if rtc, clock duration in microseconds
      clock count <n>;           // if rtc, ticks per minor cycle.
   }

   process "<program_name>" on "<target_name>" {
      NightView <boolean> ;      // schedule under NightView, {True | False}
      xterm <boolean> ;          // run under an xterm(1), {True | False}
      dir "<name>" ;             // full pathname of working directory on target
      input <style> ;            // input source, {File | Standard}
      infile "name" ;            // full pathname of input file
      output <style> ;           // output destination, {File | Standard}
      outfile "<name>" ;         // full pathname of output file
      privilege "<privlist>" ;   // working privileges, see below
      policy <p>;                // scheduling policy, p = {R | O | P}
      priority <n>;              // scheduling priority
      parameter <n>;             // program parameter.  if absent, -1
      soft overruns <n>;         // soft overrun limit.  if absent, no limit
      cpu <mask>;                // cpu bias mask, see below
      start cycle <n>;           // starting cycle
      period <n>;                // period
   } ...

}

NOTE

T he va lue s  fo r  <name>,  <program_name> ,
<target_name> , and <privlist>  must be enclosed in dou-
ble quotes (" )
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The <perms>  specification is a sequence of one or more of the following:

owner=<permspec>
group=<permspec>
other=<permspec>

where <permspec>  is either ’r ’, ’ w’, or ’rw ’.

The <dist_kind>  specification is one of the following values:

“None” target names must match the timing-host name

“Closely Coupled” targets must be in the same cluster as timing-host

“RCIM Coupled” targets are on the same RCIM chain as timing-host.

The <boolean>  specifications should have a simple boolean keyword:

True the feature is enabled

False the feature is disabled

The <style>  specifications should have one of the following values:

File input/output should be redirected from/to a file on th
target system.  A name must be provided.

Standard I/O should be performed to/from standard I/O stream
Standard Input, or Standard Error.

NOTE

If both xterm  and NightView  boolean parameters are False ,
then the <style>  specifications for input  and output  must
both be File .

The <privlist>  specification should contain a comma-separated list of sim
privilege names.  For example: 

"owner,dev,rtime"

See intro(2)  for more information on privileges.

The <mask> specification can be a comma-separated list of mask specifiers.  E
specifier can be a CPU number (specified as an integer), a range of CPU numb
the form <n>-<m> , or the keyword active , indicating all active CPUs on the sys
tem.

Configuration File Example 1

The following is an example of the configuration file associated with the scheduler in
ure 4-3, “Sample Scheduler Window,” on page 4-8.
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Scheduler 2 {
   cycles 8;
   tasks total 10;
   tasks per cycle 10;
   permissions owner=rw;
   distribution RCIM coupled;

   timing source {
      host "buzzard";
      clock "2c2";
      clock duration 10;
      clock count 10000;
   }

   process "/tooth/tutorial/nsim/server1"
         on "papio" {
      NightView False ;
      xterm False ;
      dir "/tooth/tutorial/nsim/" ;
      input File ;
      infile "/dev/null" ;
      output File ;
      outfile "server1.papio.out" ;
      privilege "owner,dev,rtime,tshar,plock,cpubias" ;
      policy F;
      priority 59;
      parameter 1;
      soft overruns 0;
      cpu 0;
      start cycle 0;
      period 8;
   }

   process "/tooth/tutorial/nsim/server2"
         on "buzzard" {
      NightView False ;
      xterm False ;
      dir "/tooth/tutorial/nsim/" ;
      input File ;
      infile "/dev/null" ;
      output File ;
      outfile "server2.buzzard.out" ;
      privilege "owner,dev,rtime,tshar,plock,cpubias" ;
      policy F;
      priority 59;
      parameter 2;
      soft overruns 0;
      cpu 1;
      start cycle 0;
      period 8;
   }
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   process "/tooth/tutorial/nsim/server3"
         on "yoshi" {
      NightView False ;
      xterm False ;
      dir "/tooth/tutorial/nsim" ;
      input File ;
      infile "/dev/null" ;
      output File ;
      outfile "server3.yoshi.out" ;
      privilege "owner,dev,rtime,tshar,plock,cpubias" ;
      policy F;
      priority 59;
      parameter 3;
      soft overruns 0;
      cpu active;
      start cycle 0;
      period 1;
   }

}

Configuration File Conversion 1

NightSim 2.4 and earlier versions supported configuration files consisting of a sequ
of rtcp  commands.  While NightSim still retains the ability to generate a script cont
ing rtcp  commands, the "configuration" is now saved to a file with an enhanced fo
that supports the concept of a distributed FBS, allowing for processes to be scheduled in
synchronized manner on more than one target computer (see “Configuration File Fo
on page A-1).

Configuration files created by NightSim 2.4 and earlier versions will be converted to
new format automatically when opened by NightSim.  Save your configuration file a
after opening to complete the conversion.

NOTE

The conversion of configuration files will not occur on Linux
systems.
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Appendix BResources

This appendix details the X resources, NightStar resources, and widget hierarchy in N
Sim.

X Resources 2

The following X resources are available for configuring the behavior of NightSim:

*defaultClockRes

Specifies the default resolution in microseconds that is to be used when config
a real-time clock. Permissible values are 1, 10, 100, 1000, and 10000. The d
value is 10.

*defaultPermissions

Specifies the default access permissions to be used when creating a new sch
The value is an octal number in the same format used by chmod(1) . The default
value is 600.

*defaultUpdateRate

Specifies the default rate in seconds that is to be used for updating the run 
fields in the Scheduler window and taking repetitive queries in the Monitor win-
dow.  Minimum value is 0.01 second; maximum value is 100 seconds; default v
is 1.0 second.

*defaultMonitorRes

Specifies the default resolution in microseconds of time-based fields in the Monitor
window. Permissible values are 1, 10, 100, 1000, and 10000; the default value

*displayTitle1 - *displayTitle9

*displayFields1 - *displayFields9

These resources are used to specify the predefined sets of performance m
fields. Up to 9 sets of fields can be defined. The displayTitle n resource is a
string that defines a name for field set n, and the displayFields n resource is a
B-1
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lows:

targ Target system

fpid FPID of the process

spid system PID of the process

name program name

prio program priority

stcy starting cycle

peri period

cpum CPU bias

itrc iteration count

lcyt last cycle time

tott total time

avgt average cycle time

sorc soft overrun count

ovrc overrun count

prcn percent of period used

mnct minimum cycle time

mncf minimum cycle frame

mncc minimum cycle cycle

mnft minimum frame time

mnff minimum frame frame

mxct maximum cycle time

mxcf maximum cycle frame

mxcc maximum cycle cycle

mxft maximum frame time

mxff maximum frame frame

intr inclusion/exclusion of interrupt time

As an example, the following is the default for the first field set:

*displayTitle1:   Summary Fields
*displayFields1:  targ fpid name cpum itrc lcyt tott 
avgt sorc ovrc prcn

*offline

Specifies whether new Scheduler windows should be initially Off-Line (True ) or
On-Line (False ).  See “On-Line/Off-Line Operation” on page 4-5 for more info
mation.

*expert

Specifies whether the user is running in expert mode (True  or False ).  The default
value is False .

*serverStartTimeout

Specifies the amount of time (in seconds) that NightSim should allow for the Ni
Sim server to start up on a target system.  If the server does not start succes
B-2
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within this time period, but no error is received, NightSim aborts the operation
displays an error message.

The default value is 15 seconds.  You may need to specify a longer time for slo
heavily-loaded networks or target systems.

*serverMessageTimeout

Specifies the amount of time (in seconds) that NightSim should allow for the Ni
Sim server to respond to a message.  If the server does not respond withi
period, NightSim will assume that the server has terminated or that the remote 
is inoperative.  NightSim will then abort the operation and display an error mess

The default value is 20 seconds.  You may need to specify a longer time for slo
heavily-loaded networks or target systems.

*extendedResponseTimeout

Specifies the maximum length of time (in seconds) that NightSim should allow
the NightSim server to respond with a longer response to a message.  For exa
the length of time NightSim should wait for the NightSim server to read a rem
directory and return the names of all the files contained within.

If the server does not respond within this time period, NightSim will assume tha
server has terminated or that the remote target is inoperative.  NightSim will 
abort the operation and display an error message.

The default value is 90 seconds.  You may need to specify a longer time for slo
heavily-loaded networks or target systems.

NightStar Resources 2

You may control NightSim's appearance using the NightStar Font Resources
NightStar Color Resources.  In most cases, however, the default values for the follo
resources should be used.

NightStar Font Resources 2

This section describes the special font resources available for NightStar tools.  In ad
to these resources, NightStar tools specify an overall default font that is used for most of
the textual display.  NightStar tools use proportional-width fonts except in areas
depend on text alignment;  in these instances a fixed-width font is important
readability.  If you decide to change fonts, make sure that you choose another fixed-
font for the font resources that have fixed in their names.

NightStar font resources include:

*smallFontList  

Used for areas that require a smaller font.
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*infoFontList  

Used for areas that display informational messages, warnings, errors. 

*fixedFontList  

Used for areas that depend on text alignment.

*smallFixedFontList  

Used for areas that depend on text alignment but require a smaller font.

The /usr/lib/X11/app-defaults/Nsim  resource file specifies the font values fo
NightSim.

NightStar Color Resources 2

This section describes the special color resources available for NightStar tools
addition to these resources, NightStar tools specify an overall default color that is used
for most of the window areas.  NightStar tools use the same color scheme to indica
they are part of the same tool set and to provide cues about the usage of different a
the windows.  Each NightStar tool uses a unique color for its menu bars.

The following NightStar color application resources are defined:

*outputBackground
*outputForeground 

Used for the background and foreground colors in output-only areas.

*inputBackground
*inputForeground  

Used for the background and foreground colors in areas that accept user input

The /usr/lib/X11/app-defaults/Nsim-color  resource file specifies the colo
values for NightSim.

Widget Hierarchy 2

Information about the widget hierarchy for the graphical user interface is usefu
modifying the behavior of NightSim through the use of standard X11 or Motif resour
You can get this information by using editres(1) .  See the man page for information
about editres .
B-4
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Appendix CReporting Bugs

This section describes how to report bugs in NightSim.  It is important to re
problems, otherwise we might never know about them.  You can report a proble
calling the Concurrent Software Support Center or by submitting a Software Ac
Request (SAR).  For details on these methods, see the section Direct Software Support in
the Release Notes for the current release.

It is also important to report a problem in a way that helps us understand and repr
the problem.

Here is a list of things you should tell us in a problem report.

• What version of NightSim are you using?  You can get this by running
nsim -version  or by activating On Version in the Help menu in the
GUI (see “Getting Help” on page 3-4).

• What type of machine are you running on, and what is the version of the
operating system?  Use the command uname -a  to get this information.

• Try to be very explicit about what you see happen when the problem
occurs.  Do you get any error messages?  Exactly what incorrect behavior
do you see?  How will we know when we have reproduced the problem?

• Try to isolate the problem to a minimal test case.

• Be explicit about exactly how to reproduce the problem.  Try not to leave
out any facts, even if you think you know the cause of the problem.
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Glossary

active scheduler window

A Scheduler window that is associated with a scheduler that exists on the system.

closely-coupled distribution

A scheduler with a closely-coupled distribution must use a device which support
IOCTLVECNUM ioctl  command (See rtc(7)  man page).  The integral real-time
clocks and the real-time clocks and edge-triggered interrupts on the RCIM suppor
feature.

closely-coupled system

A closely-coupled system is a set of single-board computers (SBCs) which share the same
VMEbus.  The first board must have an attached system disk and acts as the file ser
the other boards in the VMEbus.  The VMEbus can be used for various types of 
board communication.  A closely-coupled system is also known as a cluster.

cluster

A cluster is one or more single-board computers (SBCs) which reside on the same VME
bus.  In general, a cluster may be viewed as a number of SBCs which reside in the
VME chassis.  A cluster is also referred to as a closely-coupled system.

distributed FBS

An FBS configured by NightSim which allows for processes to be scheduled in a sync
nized manner on more than one target computer.  See closely-coupled distribution.

distributed timing device

A timing device may be registered as either a closely-coupled timing device or a
RCIM-coupled timing device for use with a distributed frequency-based scheduler. 
fbs_register_rdev(3rt)  man page).

If registered as a closely-coupled timing-device on the SBC where it actually resides, the
device is available for use on all other SBC's in the same cluster.  If registers as an RCIM-
coupled timing device on the host where the RCIM device actually resides, the remote tim
ing device is available to all others targets in the RCIM chain.

end–of–cycle scheduling

A form of frequency–based scheduling in which scheduling is triggered when the
process that is scheduled to execute in the current minor cycle of the current major frame
completes its processing.
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expert mode

A mode specified by setting the expert  X resource to True , allowing the user to see
more detailed information about the current FBS in the Scheduler window.

FBS

Frequency-based scheduler.

FBSMNI 

A system tunable parameter that is associated with the frequency–based scheduler.  It
specifies the maximum number of frequency–based schedulers that can be configu
one time system–wide.

FBSUNSCHEDMAX

A system tunable parameter that is associated with the frequency-based scheduler. It
specifies the maximum number of unscheduled processes that is permitted on a freq
based scheduler.

FPID

A unique frequency–based scheduler process identifier that is returned when a program
scheduled on a frequency–based scheduler.

frame overrun

The condition that occurs when an FBS–scheduled process does not finish its process
before it is scheduled to run again.

frequency-based scheduler

A high resolution task synchronization mechanism that enables processes to run a
specified frequencies.

high-resolution timing facility

A feature that provides a means of measuring each process’s or LWP’s execution tim

host system

A system designated by a host name.  A host may be an SBC in a cluster, a stand-alone
computer system, or a node in a network of computer system connected by etherne
NightSim host, timing host, target system.

idle time

Time during which the CPU is not busy.

inactive scheduler window

A Scheduler window that is not associated with an existing scheduler.
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One instance of a process’s being wakened by a frequency–based scheduler. 

KoalaTalk

The inter-tool communication mechanism used by NightSim to exchange mess
among its components.  It is provided with the X Window System.

last time 

A value returned by the performance monitor indicating the amount of time that an FBS–
scheduled process has spent running from the last time that it has been wakened
scheduler until it has called fbswait . 

loosely-coupled system

Two or more target systems connected via either Ethernet or RCIMs and RCIM cables.

major frame 

One pass through all of the minor cycles with which a frequency–based scheduler is
configured. A major frame has associated with it a duration, which is obtaine
multiplying the duration of a minor cycle by the number of minor cycles per major fra

maximum cycle cycle 

A value returned by the performance monitor indicating the number of the minor cycle in
which the maximum cycle time has occurred. 

maximum cycle frame 

A value returned by the performance monitor indicating the number of the major frame in
which the maximum cycle time has occurred. 

maximum cycle time 

A value returned by the performance monitor indicating the greatest amount of time tha
an FBS–scheduled process has spent running in a cycle. 

maximum frame frame 

A value returned by the performance monitor indicating the number of the major frame in
which the maximum frame time has occurred. 

maximum frame time 

A value returned by the performance monitor indicating the greatest amount of time tha
an FBS–scheduled process has spent running during a major frame. 
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minimum cycle cycle 

A value returned by the performance monitor indicating the number of the minor cycle in
which the minimum cycle time has occurred. 

minimum cycle frame 

A value returned by the performance monitor indicating the number of the major frame in
which the minimum cycle time has occurred. 

minimum cycle time 

A value returned by the performance monitor indicating the least amount of time that a
FBS–scheduled process has spent running in a cycle. 

minimum frame frame 

A value returned by the performance monitor indicating the number of the major frame in
which the minimum frame time has occurred. 

minimum frame time 

A value returned by the performance monitor indicating the least amount of time that a
FBS–scheduled process has spent running during a major frame. 

minor cycle 

The smallest unit of frequency maintained by a frequency–based scheduler. A minor cycle
has associated with it a duration, which is the time that elapses between inter
generated by the timing source that is attached to the scheduler. If the timing sourc
real–time clock, the minor cycle duration is defined by specifying the number of c
counts per minor cycle and the number of microseconds per clock count.

NightSim host

The system from which NightSim was invoked.

NightSim server

The NightSim server is a program that executes on a target system and performs system-
level actions on behalf of NightSim.  Whenever NightSim needs to perform an oper
on a target system, such as creating an FBS, scheduling a program on an FBS, or startin
or stopping an FBS, NightSim makes a request of the NightSim server on that targe
tem.  NightSim automatically takes care of starting up a NightSim server on a targe
tem when needed.

number of overruns 

A value returned by the performance monitor indicating the number of times that an FBS–
scheduled process has caused a frame overrun. 
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performance monitor 

A mechanism that makes it possible to monitor use of the CPU by processes th
scheduled on a frequency–based scheduler. 

period 

A frequency–based scheduler scheduling parameter that specifies the frequency w
which a specified program is to be wakened in each major frame. A period of one indi-
cates that the program is to be wakened every minor cycle; a period of two indicates that it
is to be wakened once every two minor cycles; and so on.

privilege 

A mechanism through which processes are allowed to perform sensitive operatio
override system restrictions.

process dispatch latency 

The time that elapses from the occurrence of an external event, which is signified 
interrupt, until the process that is waiting for that external event executes its 
instruction in user mode. 

RCIM

Real-Time Clocks and Interrupt Module - an optional hardware module which prov
both real-time clocks and edge-triggered interrupt pins for the host to which it is attached,
allowing those devices to be used as timing and interrupt sources for that host.  R
may be connected, and therefore synchronized, via RCIM cables.  RCIM real-time c
and edge-triggered interrupts may be used locally or registered as distributed ti
devices for use as either closely-coupled timing devices or as RCIM-coupled tim
devices  (See the fbs_register_rdev(3rt)  man page).

RCIM-coupled distribution

Distribution of scheduling interrupts to targets on an RCIM chain.  A scheduler with
RCIM-coupled distribution requires the use of an RCIM-distributed device as a timing
source.

RCIM-distributed device

An RCIM timing device whose interrupts are configured to be distributed via an RC
cable  between RCIMs on mul t ip le target  systems.  When regis tered us ing
fbs_register_rdev(3rt) , such a device may be used as either an RCIM-coup
timing device or a closely-coupled timing device.

SBC

Single-board computer.

scheduler key 

A user–supplied numeric identifier for a frequency–based scheduler.
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See NightSim server.

soft overrun

Soft overruns are a type of frame overrun which give the scheduled process a chance
recover and return to synchronization.  When scheduling a process, you can specify 
secutive soft overrun limit count that this process will tolerate and have processed a
overruns by the kernel.  Soft overruns are catastrophic failures only if the process re
its limit on the number of soft overruns tolerated.  This soft overrun limit defaults to 0
each process. 

spare time 

Processor time that is composed of the following: (1) idle time, (2) CPU time of processes
that are not scheduled on a frequency–based scheduler, and (3) CPU time of FBS–
scheduled processes for which performance monitoring has not been enabled. 

starting base cycle 

A frequency–based scheduler scheduling parameter that specifies the first minor cycle in
which an FBS–scheduled process is to be wakened in each major frame.

target system

Any system on which processes will be scheduled.

timing host

The system on which the timing device physically resides.

timing mode 

The mode under which the performance monitor runs. It specifies whether time spen
servicing interrupts is to be included in or excluded from performance monitor tim
values. 

total iterations 

A value returned by the performance monitor indicating the number of times that an FBS–
scheduled process has been wakened by the scheduler. 

total time 

A value returned by the performance monitor indicating the total amount of time that a
FBS–scheduled process has spent running in all cycles. 

unscheduled process 

A process that is not wakened by the frequency–based scheduler and does not call
fbswait; it is not scheduled to run at a certain frequency. 
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